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우리 제품을 구입해 주셔서 감사합니다. 문의 사항이나 요청 사항이 있으면 대리점에 문의하십시오. 

Disclaimer 

 
CAUTION! 

기본 암호는 첫 번째 로그인에 사용됩니다. 계정 보안을 유지하려면 처음 로그인 한 후에 암호를 

변경하십시오. 강력한 암호를 설정하는 것이 좋습니다 

 

 해당 법률에서 허용하는 최대 범위 내에서 하드웨어, 소프트웨어, 펌웨어 및 문서와 함께 설명 

된 제품은 "있는 그대로"제공됩니다. 

 이 매뉴얼의 내용의 무결성과 정확성을 검증하기 위해 최선의 노력을 기울 였지만이 매뉴얼의 

진술, 정보 또는 권장 사항은 어떠한 종류의 명시 적 또는 묵시적 보증을 구성하지 않습니다. 

우리는이 설명서의 기술적 또는 인쇄상의 오류에 대해 책임을지지 않습니다. 이 설명서의 

내용은 사전 통보없이 변경 될 수 있습니다. 업데이트가이 설명서의 새 버전에 추가됩니다. 

 이 매뉴얼의 사용과 그 결과는 전적으로 사용자의 책임하에 이루어져야 합니다. 어떠한 

경우에도 본 제품의 사용과 관련하여 비즈니스 이익 손실, 비즈니스 중단 또는 데이터 또는 

문서의 손실에 대한 손해를 포함하여 특별, 간접, 우발적 또는 간접적인 손해에 대해 귀하에게 

귀속됩니다. 

 비디오 및 오디오 감시는 국가마다 다른 법률에 의해 규제 될 수 있습니다. 이 제품을 감시 

목적으로 사용하기 전에 해당 지역의 법률을 확인하십시오. 우리는 장치의 불법적인 작동으로 

인한 결과에 대해 책임을지지 않습니다. 

 이 설명서의 그림은 참조용이며 버전이나 모델에 따라 다를 수 있습니다. 이 설명서의 스크린 

샷은 특정 요구 사항 및 사용자 기본 설정을 충족하도록 사용자 정의되었을 수 있습니다. 

결과적으로, 소개 된 예제 및 기능 중 일부는 모니터에 표시된 것과 다를 수 있습니다. 

 이 설명서는 여러 제품 모델을 위한 안내서이므로 특정 제품을 대상으로하지 않습니다. 

 물리적 환경과 같은 불확실성으로 인해 본 설명서에 제공된 실제값과 참조값 간에 불일치가 

있을 수 있습니다. 궁극적인 해석의 권리는 우리 회사에 있습니다. 

 Environmental Protection 

이 제품은 환경 보호에 대한 요구 사항을 준수하도록 설계되었습니다. 이 제품의 올바른 보관, 사용 

및 처분을 위해 국내 법률 및 규정을 준수해야합니다. 

Symbols 

다음 표에 있는 기호는 이 설명서에서 찾을 수 있습니다. 위험한 상황을 피하고 제품을 올바르게 

사용하려면 기호에 표시된 지침을 주의해서 따르십시오. 



 

Symbol Description 

WARNING! 중요한 안전 지침을 포함하고 신체 상해를 초래할 수 있는 상황을 나타냅니다. 

CAUTION! 주의 사항 및 부적절한 조작은 제품의 손상 또는 오작동을 유발할 수 있습니다. 

NOTE! 제품 사용에 대한 유용하고 보충적인 정보를 의미합니다. 
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1 

1  Network Connection 

PC 에서 네트워크 카메라 (IP 카메라 또는 IPC 라고도 함) 에 액세스하기 전에 네트워크 카메라 또는 

스위치 또는 라우터를 통해 네트워크 카메라를 PC 에 직접 연결해야합니다. 

 

Shielded Twisted Pair (STP) 케이블을 사용하여 네트워크 카메라와 PC 의 네트워크 인터페이스를 

연결합니다. 

 

Shielded Twisted Pair (STP) 케이블을 사용하여 카메라의 네트워크 인터페이스와 스위치 또는 라우터를 

연결합니다. 

2  Login 

Preparation 

퀵 가이드에 따라 설치를 완료 한 후 카메라를 전원에 연결하여 카메라를 시작합니다. 카메라가 

시작되면 웹 브라우저에서 카메라에 액세스 할 수 있습니다. Internet Explorer (IE)는 권장되는 웹 

브라우저입니다.  

다음은 Microsoft Windows 7.0 운영 체제에서 IE 를 예로 들어 설명합니다. 

Check before login 

 카메라가 올바르게 작동하고 있는지 확인합니다. 

 PC 와 카메라의 네트워크 연결은 정상입니다. 

 PC 는 Internet Explorer 8.0 이상으로 설치됩니다. 

 (옵션) 해상도는 1440 x 900 으로 설정됩니다. 

Network cable

IPC PC

IPC PCSwitch or Router

Network cable Network cable
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Add the IP address as a trusted site 

 

 

1

2

http://192.168.0.13

3

4

5

6

Clear the check box

7
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NOTE! 

이 예제의 IP 주소 192.168.0.13/192.168.1.13 이 기본 IP 주소입니다. 변경된 경우 카메라의 실제 주소로 

교체하십시오. 

 

(Optional) Modify user access control settings 

카메라에 액세스하기 전에 단계에 따라 사용자 계정 컨트롤 설정을 알림 안 함으로 설정합니다. 

 

Logging In to the Web Interface 

카메라의 기본 고정 IP 주소는 192.168.1.13 또는 192.168.0.13 이며 기본 서브넷 마스크는 

255.255.255.0 입니다. 

DHCP 는 기본적으로 켜져 있습니다. DHCP 서버가 네트워크에서 사용되는 경우, 카메라의 IP 주소가 

동적으로 할당 될 수 있으며 올바른 IP 주소를 사용하여 로그인해야 합니다.  

다음은 IE 를 예로 들어 로그인 절차를 설명합니다. 

1. 주소 표시 줄에 카메라의 올바른 IP 주소를 입력하여 로그인 페이지를 찾습니다. 

 

2. 처음으로 로그인하는 경우 시스템 프롬프트에 따라 ActiveX 를 설치합니다. 설치를 완료하려면 

브라우저를 닫아야합니다. 

1

2

3

4
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NOTE! 

 ActiveX 를 수동으로 로드하려면 검색 주소창에 http : // IP address / ActiveX / Setup.exe 를 입력하고 

Enter 키를 누릅니다. 

 기본 암호는 처음 로그인 할 때 사용됩니다. 계정 보안을 유지하려면 처음 로그인 한 후에 암호를 

변경하십시오. 강력한 암호를 설정하는 것이 좋습니다 (8 자 이상). 

 카메라는 로그인 시도 실패 횟수를 제한하여 불법적 인 접근으로부터 자신을 보호합니다. 6 회 연속 

로그인에 실패하면 카메라가 자동으로 10 분 동안 잠 깁니다. 

 

3. 사용자 이름과 암호를 입력하고, 로그인을 클릭합니다. 첫 번째 로그인의 경우 기본 사용자 이름 

"admin"과 암호 "123456"을 사용합니다. 

 라이브 뷰가 선택된 상태에서 로그인하면 로그인시 라이브 비디오가 표시됩니다. 그렇지 않으면 

라이브 뷰 창에서 라이브 비디오를 수동으로 시작해야합니다. 

 Save Password 를 선택하여 로그인하면 로그인 할 때마다 암호를 입력 할 필요가 없습니다. 보안을 

위해 암호 저장을 선택하지 않는 것이 좋습니다. 

 사용자 이름과 암호 텍스트 상자와 암호 저장 확인란을 지우려면 재설정을 클릭합니다. 

Introduction to the Web Interface 

기본적으로 웹 인터페이스에 로그인하면 라이브 뷰 창이 표시됩니다. 다음은 그 예입니다. 

 

No. Description 

1 메뉴 

2 

PTZ 제어 영역 

Note:  

이 영역은 PTZ 돔 카메라 및 PTZ 카메라에서 사용할 수 있습니다. 

3 라이브 뷰 윈도우 

4 라이브 뷰 툴바 

1

2

3

4
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Initial Configuration 

장치에 로그인 한 후, 다음 초기 설정을 수행합니다. 

Item Description 

1. Set the TCP/IP address for the device. 
실제 네트워킹을 기반으로 장치 IP 및 네트워크를 

재설정합니다. 

2. Log out and log in again to the Web 
using the new IP address. 

- 

3. Set the system time. 실제 상황에 따라 시스템 시간을 설정합니다. 

4. (Optional) Set the management 
server. 

실제 네트워킹을 기반으로 관리 서버를 설정합니다. 

5. (Optional) Set the server for storing 
photos. 

실제 네트워킹을 기반으로 사진을 저장할 서버를 

설정합니다. 

6. Set OSD. 
필요에 따라 화면에 표시되는 정보 (예 : 시간)를 

설정합니다. 

7. (Optional) Manage users. 
기본 암호를 변경하고 필요에 따라 일반 사용자를 

추가합니다. 

 

초기 구성을 마치면 라이브 비디오를 볼 수 있습니다. 필요에 따라 다른 설정을 구성합니다. 

 
NOTE! 

 표시된 라이브 뷰 인터페이스, 표시된 설정 및 값 범위는 모델에 따라 다를 수 있습니다. 자세한 내용은 

실제 웹 인터페이스를 참조하십시오. 

 회색으로 표시된 설정은 수정할 수 없습니다. 실제 설정은 웹 인터페이스를 참조하십시오. 

 처음 로그인 할 때 암호를 변경하는 것을 권장합니다. 암호 변경 방법에 대한 자세한 내용은 보안을 

참조하십시오. 

 

3  Configuring Parameters  

Local Parameters  

PC 에서 로컬 설정을 합니다.  

 
NOTE! 

로컬 설정은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 참조하십시오. 
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1. Setup > Common > Local Settings 을 선택합니다. 

 

2. 필요에 따라 설정을 수정합니다. 다음 표는 몇 가지 주요 설정을 설명합니다. 

Parameter Description 

Intelligent 
Mark 

Untriggered 
Target 

이 항목이 설정이 되면 카메라가 대상(예 : 얼굴 인식 기능이 활성화 된 

얼굴)에 화면 마크를 표시하고 추적합니다. 

Video 

Processing Mode 

 Real-Time Priorit: 네트워크가 양호한 경우에 권장됩니다. 

 Fluency Priority: 라이브 영상에 짧은 시간 지연이 필요한 경우에 

권장됩니다. 

 Ultra-low Latency: 라이브 영상의 최소 시간 지연을 원할 때 

권장됩니다. 

Protocol 
PC가 디코딩 할 미디어 스트림을 전송하는 데 사용되는 프로토콜을 

설정합니다. 

Record 
and 
Snapshot 

Recording 

 Subsection By Time: 컴퓨터의 각 녹화 파일에 대해 녹화 된 영상의 

기간(duration?). 예 : 2 분. 

 Subsection By Size: 컴퓨터에 저장된 각 녹음 파일의 크기. 예 : 5M. 

Record 
Overwrite 

 Overwrite: 컴퓨터의 할당된 저장 공간이 모두 소모되면 카메라는 

기존의 녹화 파일을 삭제하여 새 녹화 파일을 위한 공간을 

만듭니다. 

 Full Stop: 컴퓨터의 할당된 저장 공간이 가득 차면 녹화가 자동으로 

중지됩니다. 

 

3. Save 를 클릭합니다. 
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Network Configuration  

Ethernet 

카메라가 다른 장치와 통신 할 수 있도록 카메라의 IP 주소와 같은 통신 설정을 수정합니다. 

 
NOTE! 

 IP 주소를 변경 한 후에는 새로운 IP 주소를 사용하여 로그인해야합니다. 

 DNS (Domain Name System) 서버의 구성은 장치가 도메인 이름으로 액세스 할 때 적용됩니다. 

 

Static Address 

1. Setup > Network > Network 클릭합니다. 

  

2. Obtain IP Address 드롭 다운 목록에서 Static 을 선택합니다. 

3. IP 주소, 서브넷 마스크 및 기본 게이트웨이 주소를 입력합니다. 카메라의 IP 주소가 네트워크에서 

고유한지 확인합니다. 

4. Save 를 클릭합니다. 

PPPoE 

 
NOTE! 

일부 모델에서는이 기능을 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

카메라가 PPPoE (Point to Point over Ethernet)를 통해 네트워크에 연결되어 있으면 PPPoE 를 IP 

obtainment mode 로 선택해야합니다 

1.  Setup > Network > Network 를 클릭합니다.  
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2. Obtain IP Address 드롭 다운 목록에서 PPPoE 를 선택합니다. 

3. 인터넷 서비스 공급자 (ISP)가 제공 한 사용자 이름과 암호를 입력합니다. 

4. Save 를 클릭합니다.  

DHCP 

DHCP (Dynamic Host Configuration Protocol)는 기본적으로 카메라가 제공 될 때 활성화됩니다. DHCP 

서버가 네트워크에 배포 된 경우, 카메라는 DHCP 서버에서 IP 주소를 자동으로 가져올 수 있습니다. 

DHCP 를 수동으로 설정하려면, 아래 단계를 수행하십시오. :  

1. Setup > Network > Network 을 클릭합니다. 

 

2. Obtain IP Address 드롭 다운 목록에서 DHCP 를 선택합니다. 

3. Save 를 클릭합니다. 

IPv6 

1. Setup > Network > Network 를 클릭합니다. 
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2. 기본적으로 IPv6 모드는 수동으로 설정됩니다. 

3. IPv6 주소를 입력하고 접두사 길이 및 기본 게이트웨이를 설정합니다. IP 주소는 네트워크에서 

고유해야 합니다. 

4. Save 를 클릭합니다. 

Wi-Fi 

 
NOTE! 

일부 모델에서는이 기능을 지원하지 않으므로 자세한 내용은 실제 모델을 참조하십시오. 

1. Setup > Network > Network 를 클릭합니다. Wi-Fi tab 을 클릭합니다.  

 

2. Sniffer 를 선택합니다.  

3. Save 를 클릭합니다. 

Port 

 

 
NOTE! 

일부 모델에서는이 기능을 지원하지 않으므로 자세한 내용은 실제 모델을 참조하십시오. 

1. Setup > Network > Port 를 클릭합니다. 

 

2. 관련 포트 번호를 구성합니다. 

3. Save 를 클릭합니다. 

FTP 

FTP 구성 후 네트워크 카메라의 스냅 샷을 지정된 FTP 서버에 업로드 할 수 있습니다. 

General 

1. Setup > Storage > FTP 를 클릭합니다. General tab 으로 이동합니다.  
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2. FTP 서버에 이미지를 업로드하는 데 사용되는 FTP server, username 및 password 의 IP 주소 및 

포트를 설정하고 Upload Images, Overwrite Storage 및 Overwrite At 설정 (이미지 덮어 쓰기 임계 

값)을 선택합니다. 

3. FTP 서버에 스냅 샷 저장 경로와 파일 이름 형식을 설정합니다. 

4. Save 를 클릭합니다. 

Smart 

이 기능은 얼굴 인식 및 사람 카운팅과 같은 스마트 기능을 위해 찍은 스냅 샷을 저장하는 데 

사용됩니다. 

1. Setup > Storage > FTP 를 클릭합니다. Smart tab 으로 이동합니다.  
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2. FTP 서버에 이미지를 업로드하는 데 사용되는 FTP 서버의 IP 주소와 포트, 사용자 이름 및 암호를 

설정합니다. 

3. FTP 서버에 스냅 샷 저장 경로와 파일 이름 형식을 설정합니다.ㄴ 

4. Save 를 클릭합니다.  

E-Mail 

 

전자 메일을 구성한 후, 경보가 트리거되면 지정된 전자 메일 주소로 메시지를 보낼 수 있습니다. 

1. Setup > Network > E-mail 를 클릭합니다. 

 

 

2. 보내는 사람과 받는 사람에게 연관된 파라메터 구성. 

다음 표는 몇 가지 주요 파라메터를 설명합니다. 

Parameter Description 

TLS/SSL 

이 옵션이 활성화되면, TLS (Transport Layer Security) 또는 Secure Socket Layer (SSL)을 

사용하여 전자 메일을 암호화하여 개인 정보를 보호합니다. 

먼저 SSL 연결을 통해 전송을 시도합니다. SMTP 서버가 SSL을 지원하면, 전자 메일은 

SSL 연결을 통해 전송됩니다. 그렇지 않으면 STARTTLS를 사용하여 전송을 시도합니다. 

Attach Image 
이 옵션이 활성화되면, 전자 메일에는 캡처 간격에 따라 첨부 파일로 3 개의 인스턴트 

스냅샷이 포함됩니다. 

 

3. Save 를 클릭합니다. 
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Port Mapping  

1. Setup > Network > Port 를 클릭합니다. Port Mapping tab 으로 이동합니다. 

 

2. Port Mapping 을 활성화하고 Mapping type 을 선택합니다. Manual (수동) 을 선택하면 외부 포트를 

구성해야합니다 (외부 IP 는 카메라에 의해 자동으로 획득 됨). 구성된 포트가 사용 중이면 Status 

가 Inactive (비활성) 로 표시됩니다. 

3. Save 를 클릭합니다. 

DNS 

1. Setup > Network > DNS 를 클릭합니다. 

 

2. DNS server addresses 를 설정합니다.  

3. Save 를 클릭합니다. 

DDNS  

 
NOTE!  

일부 모델에서는이 기능을 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Setup > Network > DDNS 를 클릭합니다. 

 

2. DDNS Service 를 활성화합니다. 

3. DDNS type 을 선택합니다.: DynDNS, NO-IP, 또는 EZDDNS. 
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4. 서버 주소, 도메인 이름, 사용자 이름 및 암호를 포함한 기타 설정을 완료합니다.  

5. Save 를 클릭합니다. 

802.1x 

802.1x 는 네트워크에 연결하려는 장치 (예 : 카메라)에 인증을 제공합니다. 인증 된 장치 만 네트워크에 

연결할 수 있습니다. 이것은 보안을 강화해 줍니다.  

1. Setup > Network > 802.1x 를 클릭합니다. 

 

2. On 을 선택한 다음 다른 설정을 완료합니다.  

3. Save 를 클릭합니다.  

Image Configuration 

Image Adjustment 

 
NOTE! 

 표시되는 이미지 파라메터와 허용되는 값 범위는 카메라 모델에 따라 다를 수 있습니다. 카메라의 

실제 파라메터와 값 범위는 웹 인터페이스를 참조하십시오. 슬라이더를 이동하여 설정을 

조정하거나 텍스트 상자에 직접 값을 입력 할 수 있습니다. 

 Default 을 클릭하면 모든 기본 이미지 설정이 복원됩니다. 

 

Setting the Scene 

다른 장면의 라이브 비디오를 기반으로 원하는 이미지 효과를 얻기 위해 이미지 파라메터를 

설정합니다. 

Setup > Image > Image 를 클릭합니다. 

일부 모델의 장면 관리 페이지는 다음과 같이 표시되며 드롭 다운 목록에서 원하는 장면을 선택할 수 

있습니다. 

 

일부 모델의 장면 관리 페이지는 다음과 같이 표시됩니다. 다음 단계에 따라 장면을 구성 할 수 

있습니다. 
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1. Scenes 을 클릭합니다. 

2. 장면을 선택하고 장면 전환 파라메터를 설정하십시오. 다음 표는 몇 가지 주요 파라메터를 

설명합니다. 

Column Description 

Current 

사용중인 장면을 나타냅니다. 

Note: 

 장면으로 전환하고 장면에 해당하는 이미지 파라메터를 표시하려면 옵션 버튼을 

선택합니다. 

 Auto Switching 이 선택되면 카메라가 현재 장면을 자동으로 전환합니다. 

Scene Name 

현재 장면의 이름입니다. 이 장치는 여러 가지 사전 설정 장면 모드를 제공합니다. 

장면을 선택하면, 해당 이미지 파라메터가 표시됩니다. 실제 필요에 따라 이미지 

설정을 조정할 수 있습니다. 

 Common: 야외 장면에 권장됩니다. 

 Indoor: 실내 장면에 권장됩니다. 

 High Sensitivity: 저조도 환경에 권장됩니다. 

 Highlight Compensation: 도로의 헤드 라이트 및 공원의 스포트라이트와 같은 강한 

빛을 억제 할 수 있습니다. 차량 번호판 캡처에 권장됩니다. 

 WDR: 복도, 현관 문 또는 밝고 바깥 쪽이지만 희미한 다른 장면과 같이 

콘트라스트가 높은 조명이 있는 장면에 적합합니다. 

 Custom: 필요에 따라 장면 이름을 설정합니다. 

Auto Switching 

장면을 auto-switching 목록에 추가할지 여부를 나타냅니다. 

Note: 

 Auto Switchin 을 선택하면 장면 전환 조건이 충족될때 시스템이 자동으로 장면으로 

전환됩니다. 기본적으로 auto-switching 목록에는 기본 장면이 포함됩니다. 

Setup 

클릭하면 일정, 조명 및 현재 고도 (PTZ와 수평 방향 간의 각도)를 포함한 auto-switching 

조건을 설정합니다. 설정된 시간 동안 조명과 현재 고도가 설정된 조건을 충족하는 

경우에만 auto-switching이 트리거됨을 의미합니다. 시작 및 종료 값이 모두 0으로 

설정된 경우 조건은 유효하지 않습니다. 

 

3. 장면을 선택한 다음 을 클릭하여 기본 장면으로 설정합니다.ㄴ 
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4. Auto-switching 이 활성화 된 경우, 기본값이 아닌 장면으로 전환하기위한 조건이 충족되면 

카메라가 장면으로 자동 전환 될 수 있습니다. Auto-switching 이 활성화되어 있지 않으면 카메라가 

현재 장면에 남아 있습니다. 

 
NOTE! 

 Auto Switching 이 활성화되면 (장면 설정을 사용할 수 없음) 장치가 설정된 장면 사이를 전환합니다. 

그렇지 않은 경우 기기는 현재 장면에 머물러있게됩니다. 기본값이 아닌 장면이 트리거되지 않는 한 

장치는 기본 장면에 머물러 있습니다. 

 여러 개의 기본이 아닌 장면이 트리거되면, 장치는 최소 숫자 (1 에서 5 까지)인 장면으로 전환됩니다. 

 

Image Enhancement 

 
NOTE! 

이 기능은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 참조하십시오. 

 

1. Setup > Image > Image 클릭한 다음 Image Enhancement 를 클릭합니다. 

 

2. 슬라이더를 사용하여 설정을 변경합니다. 값을 직접 입력 할 수도 있습니다. 다음 표는 몇 가지 

주요 파라메터를 설명합니다. 

Item Description 

Brightness 

이미지 밝기를 설정합니다. 

  

Low brightness High brightness 
 

Saturation 

색상에 포함된 색조의 양입니다. 

  

Low saturation High saturation 
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Item Description 

Contrast 

가장 어두운 픽셀과 가장 흰색 픽셀 사이의 차이 정도를 설정합니다. 

  

Low contrast High contrast 
 

Sharpness 

이미지의 객체 경계를 대비합니다. 

  

Low sharpness High sharpness 
 

2D Noise 
Reduction 

이미지의 노이즈를 줄입니다. 이 기능은 이미지 번짐을 유발할 수 있습니다. 

3D Noise 
Reduction 

이미지의 노이즈를 줄입니다. 이 기능은 동작 흐려짐 (일부 응용 프로그램에서는 

고스트 현상)을 유발할 수 있습니다. 

Image 
Rotation 

이미지 회전 

  

Normal Flip Vertical 

  

Flip Horizontal 180° 
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Item Description 

  

90° Clockwise  90° Anti-clockwise  
 

 

3. 이 영역의 기본 설정을 복원하려면 Default 을 클릭합니다. 

Exposure 

 
NOTE! 

 이 기능은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 참조하십시오. 

 기본 설정은 장면 적응형입니다. 수정이 필요하지 않으면 기본 설정을 사용하십시오. 

 

1. Setup > Image > Image 를 클릭한 다음 Exposure 를 클릭합니다. 

 

2. 필요에 따라 파라메터를 설정합니다. 다음 표는 몇 가지 주요 파라메터를 설명합니다. 

Parameter Description 

Exposure 

Mode 
원하는 노출 효과를 얻기 위해 올바른 노출 모드를 선택합니다. 

Shutter (s) 

셔터는 렌즈에 들어오는 빛을 제어하는 데 사용됩니다. 빠른 셔터 속도는 빠른 모션 

장면에 이상적입니다. 느린 셔터 속도는 천천히 변화하는 장면에 이상적입니다. 

Note: 

 Exposure mode 를 Manual 또는 Shutter Priority 으로 설정하면 셔터 속도를 설정할 

수 있습니다 

 Slow Shutter 가 Off 로 설정된 경우, 셔터 속도의 역수는 프레임 속도보다 

커야합니다. 

Gain (dB) 
카메라가 조명 조건에 따라 표준 비디오 신호를 출력하도록 이미지 신호를 

제어합니다. 
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Parameter Description 

Note:  

 Exposure Mode 가 Manual 또는 Gain Priority 로 설정된 경우에만이 파라메터를 설정할 

수 있습니다. 

Slow Shutter 

저조도 조건에서 이미지 밝기를 향상시킵니다. 

Note:  

이 파라미터는 Exposure Mode 가 Shutter Priority 으로 설정되어 있지 않고 Image 

Stabilizer 이 사용되지 않는 경우에만 설정할 수 있습니다. 

Slowest 

Shutter 

노출 중에 카메라가 사용할 수있는 가장 느린 셔터 속도를 설정합니다. 

Note:  

 Slow Shutter 가 On 으로 설정된 경우에만이 파라메터를 설정할 수 있습니다. 

Compensation 

원하는 효과를 얻기 위해 필요한만큼 보정 값을 조정하십시오. 

Note:  

Exposure Mode 가 Manual 으로 설정되지 않은 경우에만이 파라메터를 설정할 수 

있습니다. 

Metering 

Control 

카메라가 빛의 강도를 측정하는 방식을 설정합니다. 

 Center-Weighted Average Metering: 주로 중앙 부분의 빛을 측정합니다. 

 Evaluative Metering: 맞춤 이미지 영역에서 빛을 측정합니다 

 Highlight compensation: 과다 노출 영역의 밝기를 무시합니다. 그러나 이 설정을 

선택하면 이미지의 전체 밝기가 감소합니다. 

Note:  

Exposure Mode 가 Manual 으로 설정되지 않은 경우에만이 파라메터를 설정할 수 

있습니다. 

Day/Night 

Mode 

 Automatic: 카메라는 조명 조건에 따라 최적의 이미지를 출력합니다. 이 모드에서 

카메라는 야간 모드와 낮 모드를 자동으로 전환 할 수 있습니다. 

 Night: 카메라는 기존의 빛을 사용하여 고품질의 흑백 이미지를 제공합니다. 

 Day: 이 카메라는 기존 조명을 사용하여 고품질의 컬러 이미지를 제공합니다. 

Day/Night 

Sensitivity 

낮 모드와 야간 모드를 전환하기위한 최저 임계 값. 감도가 높으면 카메라가 빛의 

변화에보 다 민감하고 낮 모드와 야간 모드 사이를 전환하기가 더 쉬워집니다. 

Note: 

Day/Night Mode 가 Automatic 으로 설정될 때 이 파라메터를 설정할 수 있습니다.  

Day/Night 

Switching(s) 

전환 조건이 충족 된 후 카메라가 주간 모드와 야간 모드 사이를 전환하기 전까지의 

시간을 설정합니다. 

Note: 

Day/Night Mode 가 Automatic 으로 설정될 때 이 파라메터를 설정할 수 있습니다. 

WDR 

동일한 이미지에서 밝은 영역과 어두운 영역을 구별 할 수 있도록 WDR을 활성화 

합니다. 

Note:  

Exposure Mode 가 Customize 또는 Manual 이 아니고 Image Stabilizer 기능이 비활성화 

된 경우에만이 파라메터를 설정할 수 있습니다. 

WDR Level WDR 기능을 활성화 한 후 WDR 레벨을 조정하여 이미지를 향상시킬 수 있습니다. 
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Parameter Description 

Note:  

장면의 밝은 영역과 어두운 영역 사이의 콘트라스트가 높을 때 레벨 7 이상을 

사용하십시오. 콘트라스트가 낮은 경우에는 WDR 을 비활성화하거나 1-6 레벨을 

사용하는 것이 좋습니다. 

Suppress WDR 

Stripes 

활성화되면 카메라는 빛의 주파수에 따라 자동으로 느린 셔터 주파수를 조정하여 

이미지에 나타날 수있는 줄무늬를 최소화합니다. 

 

3. 기본 설정을 복원하려면 Default 을 클릭합니다. 

Smart Illumination 

 
NOTE! 

이 기능은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 참조하십시오. 

 

1. Setup > Image > Image 를 클릭한 다음 Smart Illumination 를 클릭합니다. 

 

2. 올바른 IR 제어 모드를 선택하고 파라메터를 설정합니다. 다음 표는 몇 가지 주요 파라메터를 

설명합니다. 

Parameter  Description  

Control Mode 

 Global Mode: 카메라는 IR 조명과 노출을 조정하여 균형 잡힌 이미지 효과를 냅니다. 

이 옵션을 선택하면 일부 영역이 과다 노출 될 수 있습니다. 이 옵션은 감시 범위와 

이미지 밝기를 최우선으로 할 때 권장됩니다. 

 Overexposure Restrain: 카메라는 IR 과 노출을 조정하여 과다 노출을 방지합니다. 이 

옵션을 선택하면 일부 영역이 어둡게 나타날 수 있습니다. 이 옵션은 이미지의 중앙 

부분을 명확하게 하고 과다 노출 제어를 최우선으로 할 때 권장됩니다. 

 Road: 이 모드는 전체적으로 강한 조명을 제공하며 도로와 같은 광범위한 장면을 

모니터링하는 데 적합합니다. 

 Park: 이 모드는 균일한 밝기을 제공하며 산업 단지와 같이 장애물이 많은 작은 

범위의 장면을 모니터링하는 데 권장됩니다. 

 Manual: 이 모드에서는 IR 조명의 강도를 수동으로 제어 할 수 있습니다. 

 Indoor: 이 모드는 실내 장면에서의 사용을 권장합니다. 
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Illumination 

Level 

IR 표시 등의 밝기를 설정합니다. 값이 클수록 강도가 높아집니다. 0은 IR 표시등이 꺼져 

있음을 나타냅니다. 

Note: 

 Control Mode 가 Manual 으로 설정된 경우에만이 파라메터를 설정할 수 있습니다 

 와이드 앵글 장면에서는 이 파라메터를 먼저 설정하는 것이 좋습니다. 

 장면이 중간 초점 거리를 필요로하는 경우 이 파라메터를 먼저 설정하는 것이 

좋습니다. 

 장면에 망원사진 뷰가 필요한 경우이 파라메터를 먼저 설정하는 것이 좋습니다. 

 

3. 기본 설정을 복원하려면 Default 을 클릭합니다. 

Focus  

 
NOTE! 

이 기능은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1.  Setup > Image > Image 을 클릭한 다음 Focus 를 클릭합니다. 

 

2. 필요에 따라 focus mode 를 선택합니다.  

Parameter Description 

Focus Mode 

 Auto Focus: 카메라는 현재의 밝기 상태에 따라 자동으로 초점을 맞춥니다. 

 Manual Focus: 필요에 따라 수동으로 카메라 초점을 조정하십시오. 

 One-Click Focus: 회전, 확대 / 축소 또는 사전 설정으로 이동할 때 카메라가 초점을 

맞춥니다. 

 One-Click Focus (IR): 야간이나 어두운 집과 같은 낮은 조명 조건에서 이 초점 모드는 

IR 조명을 켜면 더 좋은 효과를 냅니다. 

Scene 

 Normal: 도로 및 산업 단지와 같은 일반적인 장면에 사용됩니다. 

 Long Distance: 도로에서 장거리 모니터링에 사용됩니다. 예를 들어 먼 거리 

교차로를 감시하기 위해 카메라를 30 미터 이상 설치 한 경우. 

 

1. 기본 설정을 복원하려면 Default 을 클릭합니다. 

 

White Balance 

화이트 밸런스는 사람의 눈에 가장 잘 맞는 이미지를 출력하기 위해 서로 다른 색온도의 이미지에서 

부 자연스러운 색조를 상쇄하는 프로세스입니다. 

 
NOTE! 

이 기능은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Setup > Image > Image 를 클릭한 다음 White Balance 를 클릭합니다. 
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2. 필요에 따라 화이트 밸런스 모드를 선택하십시오. 다음 표는 몇 가지 주요 파라메터를 설명합니다. 

Parameter Description 

White Balance 

이미지의 빨강 또는 파랑 오프셋 조정: 

 Auto/Auto2: 카메라는 빛의 상태에 따라 빨간색과 파란색 오프셋을 자동으로 

조정합니다 (색상은 파란색으로 변합니다). Auto mode 에서 이미지가 여전히 부 

자연스럽게 붉거나 파란색 인 경우 Auto2 를 시도하십시오. 

 Fine Tune: 빨간색과 파란색 오프셋을 수동으로 조정할 수 있습니다. 

 Outdoor: 상대적으로 더 높은 색 온도 범위를 갖는 실외 환경에 적합합니다. 

 Locked: 변경하지 않고 현재 색 온도를 잠급니다. 

 Sodium Lamp: 카메라는 빛의 상태에 따라 적색과 청색 오프셋을 자동으로 

조정합니다 (색상은 빨간색으로 변합니다). 

Red Offset 

빨간색 오프셋을 수동으로 조정합니다. 

Note:  

 White Balance 가 Fine Tune 으로 설정된 경우만이 파라메터를 설정할 수 있습니다. 

Blue Offset 

파란색 오프셋을 수동으로 조정합니다. 

Note: 

White Balance 가 Fine Tune 으로 설정된 경우만이 파라메터를 설정할 수 있습니다. 

 

3. 기본 설정을 복원하려면 Default 를 클릭합니다. 

Advanced 

안개 또는 안개 상태에서 캡처 한 이미지의 선명도를 조정하려면 Defog 기능을 사용합니다. 

1. Setup > Image > Image 클릭한 다음 Advanced 를 클릭합니다. 

 

 
NOTE! 

 WDR 이 꺼져있을 때만이 파라미터를 설정할 수 있습니다. 

 일부 카메라 모델 만 광학 defog 를 지원합니다. defog 가 On 으로 설정되면, defog 강도 레벨 6-9 는 

광학 defog 를 나타내며, defog 강도가 레벨 5 에서 6 으로 설정되면 이미지가 색상에서 흑백으로 

바뀝니다. defog 가 Auto 로 설정되고 defog 강도 레벨이 6-9 사이 인 경우 밝은 안개 조건에서 이미지가 

자동으로 검정 / 흰색으로 변경되지 않습니다. 카메라는 안개가 심할 경우에만 자동으로 광학 defog 로 

전환됩니다. 
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2. Defog 기능을 활성화 한 다음 장면의 레벨을 선택하십시오. 레벨 9 는 최대 효과를 내고 레벨 1 은 

최소 효과를 얻습니다. 

  

Defog Off Defog On 

 

3. 기본 설정을 복원하려면 Default 을 클릭합니다. 

Lighting Type 

 
NOTE! 

이 기능은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Setup > Image > Image 을 클릭한 다음 Smart Illumination 을 클릭합니다. 

 

2. Lighting Type 드롭 다운 목록에서 옵션을 선택합니다. 

3. 기본 설정을 복원하려면 Default 을 클릭합니다. 

 

Configuring Iris and Lens Mode 

 
NOTE! 

 이 기능은 특정 네트워크 박스 카메라 유형에서만 지원됩니다. 자세한 내용은 실제 모델을 

참조하십시오. 

 P- 아이리스 제어 모드로 렌즈를 사용하고, 아이리스 제어 케이블을 카메라의 Z / F 포트에 

연결합니다. 

 Iris 는 렌즈 모드가 P-IRIS 로 설정된 경우에만 설정할 수 있습니다. 

 

1. Setup > Image > Image 를 클릭한 다음 Advanced 를 클릭합니다. 

 

2. 필요에 따라 설정을 수정하십시오. 다음 표는 몇 가지 주요 파라메터를 설명합니다. 
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Parameter Description 

Lens Mode 
 Z/F: 초점 및 줌을 수정합니다. 

 P-Iris: 아이리스 값을 수정합니다. 

Aperture 

Control 

아이리스를 자동 또는 수동으로 조정합니다. 

Note:  

Lens Mode 가 P-Iris 로 설정된 경우만이 파라메터를 설정할 수 있습니다. 

F-Number 조리개를 수동으로 변경합니다. 

 

1. 기본 설정을 복원하려면 Default 을 클릭합니다. 

 

OSD Setting 

OSD (On Screen Display)는 비디오 이미지와 함께 화면에 표시되는 텍스트이며 시간 및 기타 사용자 

정의 된 내용을 포함 할 수 있습니다. 

 
NOTE! 

이 기능은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 참조하십시오. 

 

1. Setup > Image > OSD 를 클릭합니다. 

 

일부 모델의 OSD 인터페이스는 다음과 같이 표시됩니다. 
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2. OSD 의 위치와 내용을 선택합니다. 

 Position: 라이브 뷰 영역에서 원하는 상자를 클릭합니다. 커서 모양이 변경된 후, 버튼을 클릭 

한 채로 상자를 원하는 위치로 이동합니다. 위치를 정확하게 설정하려면 오버레이 영역에서 X 

및 Y 좌표를 사용합니다. 

 Overlay OSD Content: 드롭 다운 목록은 Time, Preset 및 Serial Info 를 제공합니다. Custom 를 

선택하고 원하는 내용을 입력 할 수도 있습니다. 

 위치와 OSD 내용을 설정하면 Status 열에 기호가 나타나는데 이는 OSD 가 성공적으로 

설정되었음을 의미합니다. 각 영역에 대해 여러 줄의 내용을 설정하고 와 표시 순서를 

사용하고 조정할 수 있습니다. 

3. 설정을 완료하면 성공적인 설정을 나타내는 메시지가 나타납니다. 

미리보기 창에서 마우스 오른쪽 버튼을 클릭 한 다음 전체 화면 모드 또는 가로 세로 비율로보기를 

선택할 수 있습니다. 미리보기 창을 두 번 클릭하여 전체 화면 모드를 시작하거나 종료 할 수도 

있습니다. 

영역의 OSD 를 취소하려면 Overlay OSD Content 열에서 OSD 내용을 지우거나 위치 열에서 None 을 

선택하십시오. 다음은 시간 OSD 의 예입니다. 
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Privacy Mask 

경우에 따라 개인 정보를 보호하기 위해 카메라 이미지에 마스크 영역을 설정해야 할 수 있습니다 (예 : 

ATM 시스템의 키보드). PTZ 가 위치를 변경하거나 확대하면 프라이버시 마스크가 그에 따라 조정되어 

영역 전체를 보호합니다. 

 
NOTE! 

이 기능은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 참조하십시오 

 

1. Setup > Image > Privacy Mask 를 클릭합니다. 

  

일부 카메라 모델의 경우 다음과 같이 페이지가 표시됩니다: 
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2.  를 클릭하여 프라이버시 마스크를 추가하고, 를 클릭하여 마스크를 삭제합니다. 

 위치를 마스킹하려면: (마스크가 표시된 상태로) 상자를 클릭하여 마스크를 활성화합니다. 커서 

모양이 변경된 후 상자를 원하는 위치로 끕니다. 

 영역을 마스킹하려면: 마스크를 적용 할 영역에 마우스를 사용하여 상자를 그립니다. 

프라이버시 마스크가 구성되면 원하는 영역이 차단됩니다. 다음은 그 예입니다. 

 

Audio and Video Configuration 

Video Configuration 

카메라가 지원하는 비디오 파라메터를 설정하고 BNC 출력의 현재 상태를 볼 수 있습니다. 가능하면 

필요에 따라 하위 스트림 및 세 번째 스트림을 사용할 수도 있습니다. 
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NOTE! 

 이 기능은 모델에 따라 다를 수 있습니다. 일부 카메라 모델만이 세번째 스트림을 지원합니다. 

카메라가이 기능을 지원하는지 확인하려면 웹 인터페이스를 참조하십시오. 

 서브 또는 세 번째 스트림을 활성화 한 후, 필요에 따라 파라메터를 수정하십시오. 서브 스트림 및 

세번째 스트림에 대한 파라메터는 메인 스트림에 대한 파라메터와 동일한 의미를 갖는다. 

 

1. Setup > Video & Audio > Video 를 클릭합니다. 

 

2. 필요에 따라 설정을 수정합니다. 다음 표는 몇 가지 주요 파라메터를 설명합니다. 

Parameter Description 

Video 

Compression 

Three options: H.265, H.264 and MJPEG. 

Note: 

 비디오 압축을 H.265 또는 H.264 로 설정하면 화질을 설정할 수 없습니다. 

MJPEG 로 설정하면 1, 3, 5 의 세 가지 프레임 속도 만 사용할 수 있습니다. 비트 

전송률, I 프레임 간격, 스무딩 및 U 코드는 설정할 수 없습니다. 

 H.264 와 H.265 사이에서 설정을 변경하면 비트 레이트가 기본값으로 

변경됩니다. H.265 의 기본 비트 레이트는 H.264 의 절반입니다. 

Frame Rate 

이미지 인코딩을위한 프레임 레이트. 단위 : FPS (frame per second).  

Note: 

화질을 보장하려면 프레임 속도가 셔터 속도의 역수보다 커서는 안됩니다. 
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Parameter Description 

Bitrate Type 

 CBR: Constant Bit Rate 이것은 카메라가 일정한 데이터 속도로 데이터를 

전송한다는 것을 의미합니다. 

 VBR: Variable Bit Rate 카메라가 화질에 따라 비트 레이트를 동적으로 조정합니다. 

Image Quality 

Encoding Mode 가 VBR 이면 슬라이더를 움직여 이미지의 품질 수준을 조정할 수 

있습니다. 슬라이더를 Bit Rate 로 이동하면 비트 레이트가 감소하고 이미지 품질에 

영향을 줄 수 있습니다. 슬라이더를 Quality 로 이동하면 비트 레이트가 향상되고 

이미지 품질이 향상됩니다. 

I Frame Interval 
I 프레임이 인코딩되는 간격. 일반적으로 I 프레임 간격이 짧으면 화질은 좋아지지만 

대역폭은 더 많이 소비됩니다. 

GOP 
MPEG 비디오 인코딩의 그림 그룹. 이 파라메터는 intra-frames(I 프레임)과 inter-

frames이 정렬되는 순서를 지정합니다. 

SVC 
SVC (Scalable Video Coding)는 재생 품질을 저하시키지 않으면서 스토리지를 줄일 수 

있습니다. 

U-Code 

 Basic Mode: 실제 비트레이트는 설정된 비트레이트의 약 3/4 입니다. 

 Advanced Mode: 실제 비트레이트는 설정된 비트 전송률의 1/2 정도입니다. 

Note: 

 U- 코드가 활성화되면 비디오 압축은 H.264 및 H.265 만 지원합니다. MJPEG 는 

지원되지 않습니다. 

 U 코드가 활성화되면 캡처 모드가 30 보다 높은 프레임 레이트를 지원하지 

않습니다. 

Smoothing 

Clear를 선택하면 Smoothing이 비활성화됩니다. 슬라이더를 Smooth 로 움직이면 

스무딩의 레벨이 향상되지만 이미지 품질에는 영향을 미칩니다. 

Note:  

열악한 네트워크 환경에서는 스무딩을 활성화하여 보다 생생한 비디오를 얻을 수 

있습니다. 

BNC Output BNC 출력은 NTSC 및 PAL을 지원합니다. 

 

3. Save 를 클릭합니다. 

Audio Configuration 

오디오 구성은 카메라의 오디오 인코딩 파라메터를 설정하는 것을 의미합니다. 

 

NOTE! 

일부 모델에서는이 기능을 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Setup > Video & Audio > Audio 를 클릭합니다. 



29 

 

2. 필요에 따라 설정을 수정하십시오. 다음 표는 몇 가지 주요 파라메터를 설명합니다. 

Parameter Description 

Audio Input 

꺼짐을 선택하면 오디오 데이터가 인코딩되지 않습니다. 

Note:  

오디오가 필요하지 않은 경우 Off 를 선택하는 것이 좋습니다. 이로 인해 장치 성능이 어느 정도 

향상 될 수 있습니다. 

Access Mode 

현재 라인 / 마이크 만 있습니다. 

Note:  

이 기능은 두 개의 오디오 출력 채널이 있는 장치에서는 사용할 수 없습니다. 

Audio 

Compression 

Three options: G.711U, G.711A and ACC-LC.  

G.711U 및 G.711A는 8K 샘플링 속도 만 지원하며 ACC-LC는 8K, 16K 및 48K 샘플링 속도를 

지원합니다. 

Input Gain 샘플링을 위한 오디오 신호 증폭. Input Gain이 클수록 증폭도가 커집니다. 

Noise 

Suppression 
이미지의 노이즈를 줄이기 위해 사용됩니다. 노이즈 억제를 활성화하려면 On 을 선택합니다. 

Channel 

Audio output channel. To enable audio output, select Enable. 오디오 출력 채널. 오디오 

출력을 사용하려면 Enable 을 선택합니다. 

Note:  

일부 카메라 모델만 두 개의 채널을 지원합니다. 

 

3. Save 를 클릭합니다. 

Snapshot 

1. Setup > Video & Audio > Snapshot 를 클릭합니다. 
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2. On 를 선택한 다음 필요에 따라 해상도, 이미지 품질 및 일정을 설정합니다. 

3. Save 를 클릭합니다. 

ROI 

ROI (Region of Interest)가 활성화되면, 시스템은 비트 레이트가 불충분하면 ROI 에 대한 이미지 품질을 

보장합니다. 

 

NOTE! 

일부 모델에서는이 기능을 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Setup > Video & Audio > ROI 를 클릭합니다. 

 

2.  를 클릭 한 다음 마우스를 끌어 이미지의 의도한 부분을 덮습니다. 삭제하려면 영역을 

선택하고 를 클릭합니다. 

Media Stream Configuration 

Media Stream 

카메라에서 설정된 미디어 스트림을 표시 할 수 있습니다. UDP 또는 TCP 프로토콜에 의한 코드 

스트림을 지정된 IP 주소 및 포트 번호로 전송하도록 카메라를 설정할 수도 있습니다. 설정을 저장하고 

카메라를 다시 시작한 후에 적용 할 수 있습니다. 
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NOTE! 

 일부 모델에서는이 기능을 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 실제 필요와 네트워크 성능에 따라 전송 프로토콜 선택. 일반적으로 TCP 는 UDP 보다 우수한 이미지 

품질을 제공하지만 대기 시간도 길어집니다. 

 

1. Setup > Video & Audio > Media Stream 를 클릭합니다. 

 

2. 를 클릭하고 스트림 유형을 선택한 다음, 카메라에서 오디오 및 비디오 스트림을 수신하는 

디코딩 장치에 대한 유니 캐스트 또는 멀티 캐스트 그룹의 IP 주소 및 포트 번호를 설정합니다. 

3. 장치를 다시 시작한 후 자동으로 구성한 미디어 스트림을 설정하려면 Persistent 으로 Yes 를 

선택합니다. 

4. 스트림을 삭제하려면을 를 클릭합니다. 

5. Submit 을 클릭하여, 작업을 완료합니다. 

RTSP Multicast Address  

RTSP 멀티 캐스트 주소가 구성된 후 타사 플레이어는 RTP 프로토콜을 통해 카메라에서 RTSP 멀티 

캐스트 미디어 스트림을 요청할 수 있습니다. 

1. Setup > Video & Audio > Media Stream > RTSP Multicast Address 를 클릭합니다. 
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일부 카메라 모델의 경우, 페이지가 다음과 같이 표시됩니다. 

 

2. 멀티 캐스트 주소 (224.0.0.0 ~ 239.255.255.255)와 포트 번호 (0 ~ 65535)를 설정합니다. 

3. Save 를 클릭합니다. 
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Intelligent Alarm Configuration 

사람 수를 계산하고 움직이는 물체를 모니터링하도록 지능형 모니터링을 구성할 수 있습니다. 지능형 

모니터링에는 피플 카운팅, 침입 탐지 및 자동 추적이 포함됩니다. 

지원되는 기능은 카메라 모델에 따라 다를 수 있습니다. 

Smart Settings 

Setup > Intelligent > Smart Settings 를 클릭합니다. 

 

일부 카메라 모델의 경우, 페이지가 다음과 같이 표시됩니다. 

 

Cross Line Detection 

교차선 감지는 실시간 비디오의 가상 선을 가로지르는 객체를 감지하고, 그러한 이벤트가 감지되면 

경보를 트리거합니다. 

1. Setup > Intelligent > Smart Settings 를 클릭합니다. Cross Line 을 선택하고  을 클릭합니다. 
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2. Cross Line Detection 을 선택합니다. 

3. Detection Rule 영역에서 클릭하여 새 탐지 영역을 추가합니다. 탐지 영역을 삭제하려면을 

를 클릭합니다. 

4. 작은 미리보기 창에서 원하는 위치로 선을 끌어서 탐지 범위를 설정합니다. 

5. 교차선 감지 알람을 보고할지 여부를 결정하기 위해 카메라의 방향과 감도를 설정합니다. 

6. 필요에 따라 알람으로 트리거되는 동작 및 준비 일정을 설정합니다. 자세한 단계는 Configuring 

Motion Detection Alarm 의 알람 트리거 동작에 대한 설명을 참조하십시오. 

7. Save 를 클릭합니다. 

Intrusion Detection 

침입 탐지는 라이브 비디오의 특정 영역에 들어가는 객체를 탐지하고 그러한 이벤트가 탐지되면 

경보를 발생시킵니다. 

1. Setup > Intelligent > Smart Settings 클릭합니다. Intrusion 을 선택한 다음 을 클릭합니다. 
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2. Intrusion Detection 을 선택합니다. 

3. Detection Rule 영역에서, 클릭하여 새 탐지 영역을 추가합니다. 탐지 영역을 삭제하려면을 

클릭합니다. 

4. 상자의 테두리를 끌어 원하는 위치와 범위를 설정합니다. 

5. 카메라가 침입 탐지 경보를 보고할지 여부를 결정할 시간 임계 값, 민감도 및 백분율을 설정합니다. 

 Time Threshold: 경보가 보고되기 전에 침입자가 탐지 영역에 머문 최소 시간. 

 Sensitivity: 탐지 감도. 값이 클수록 검출 감도가 높아집니다. 

 Percentage: 경보가 보고되기 전에 지정된 감지 영역의 크기에 침입자의 크기의 최소 비율. 

6. 필요에 따라 알람으로 트리거되는 동작 및 준비 일정을 설정합니다. 자세한 단계는 Configuring 

Motion Detection Alarm 의 알람 트리거 동작에 대한 설명을 참조하십시오. 

7. Save 를 클릭합니다. 

Face Detection 

얼굴 감지 기능은 라이브 영상에서 사람의 얼굴을 감지합니다. 

1. Setup > Intelligent > Smart Settings 를 클릭합니다. Face 를 선택한 다음 을 클릭합니다. 
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2. 테두리를 끌어 원하는 위치와 범위를 설정합니다. 

3. 실제 필요에 따라 감지 파라메터를 설정합니다. 

4. Start Intelligent Analysis 를 클릭합니다. 

5. 필요에 따라 알람으로 트리거되는 동작 및 준비 일정을 설정합니다. 자세한 단계는 Configuring 

Motion Detection Alarm 의 알람 트리거 동작에 대한 설명을 참조하십시오. 

6. Save 를 클릭합니다. 

People Counting 

 

NOTE! 

 일부 카메라 모델에서만이 기능을 지원합니다. 

 지원되는 알람 트리거 및 작동 일정은 카메라 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 

인터페이스를 참조하십시오. 

 

1. Setup > Intelligent > Smart Settings 를 클릭합니다. People Counting 를 선택한 다음 를 

클릭합니다. 
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2. Enable Passenger Flow Detection 선택합니다. 탐지 모드를 선택하고, 보고서 간격과 민감도를 

설정합니다. 

3. Draw Detection Area 를 클릭 한 다음 왼쪽의 미리보기 창 (예 : 사각형)에 탐지 영역을 그립니다. 

4. Draw Entrance Direction 를 클릭 한 다음, 왼쪽의 미리보기 창에서 방향을 그립니다. 방향은 대개 

수직 또는 경사진 입니다. 

5. Max 를 설정하십시오. Filter by Object Size 아래에서 크기 및 최소 크기. 크기 범위 내의 객체만 

계산됩니다. 다른 것은 필터링되고 계산되지 않습니다. 

6. 필요에 따라 알람으로 트리거되는 동작 및 준비 일정을 설정합니다. 자세한 단계는 Configuring 

Motion Detection Alarm 의 알람 트리거 동작에 대한 설명을 참조하십시오. 

7. 계산 결과를 다시 설정하려면, Clear Counting Result 를 클릭합니다. 

8. Save 를 클릭합니다. 

Auto Tracking 

카메라는 규칙을 트리거하는 객체를 자동으로 추적합니다. 

 

NOTE! 

 일부 카메라 모델에서만이 기능을 지원합니다. 

 지원되는 알람 트리거 및 작동 일정은 카메라 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 

인터페이스를 참조하십시오. 

 

1. Setup > Intelligent > Smart Settings 을 클릭합니다. Auto Tracking 을 선택한 다음 클릭합니다. 
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2. tracking timeout (단위 : 초) 과 zoom 비율을 설정합니다.ㄴ 

3. Save 를 클릭합니다. 

Defocus Detection 

 

NOTE! 

 일부 카메라 모델에서만이 기능을 지원합니다. 

 지원되는 알람 트리거 및 작동 일정은 카메라 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 

인터페이스를 참조하십시오. 

 

디포커스 감지를 사용하여 카메라의 디포커스을 감지하고, 이벤트가 감지되면 경보를 전송합니다. 

1. Setup > Intelligent > Smart Settings 을 클릭합니다. Defocus 를 선택한 다음 을 클릭합니다. 

 

2. Defocus Detection 을 선택합니다. 

3. 필요에 따라 탐지 감도 및 경보 트리거 조치를 설정합니다. 자세한 단계는 Configuring Motion 

Detection Alarm 의 알람 트리거 동작에 대한 설명을 참조하십시오. 

4. Save 를 클릭합니다. 
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Scene Change Detection 

 

NOTE! 

 일부 카메라 모델에서만이 기능을 지원합니다. 

 지원되는 알람 트리거 및 작동 일정은 카메라 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 

인터페이스를 참조하십시오. 

 

장면 전환 감지를 사용하여 의도적인 카메라 회전과 같은 외부 요인으로 인해 발생하는 감시 환경의 

변화를 감지하고 이러한 이벤트가 감지되면 알람를보고합니다. 

1. Setup > Intelligent > Smart Settings 을 클릭합니다. Scene Change 을 선택한 다음 을 클릭합니다. 

 

2. Scene Change Detection 을 선택합니다. 

3. 감지 감도를 설정합니다. 필요에 따라 알람으로 트리거되는 동작 및 준비 일정을 설정합니다. 

자세한 단계는 Configuring Motion Detection Alarm 의 알람 트리거 동작에 대한 설명을 

참조하십시오. 

4. Save 를 클릭합니다. 

Advanced Settings 

설정에는 지능형 기능을위한 스냅 샷 선명도 및 감지 모드가 포함됩니다. 

Photo parameters 

스냅 샷의 선명도를 설정합니다. 

1. Setup > Intelligent > Advanced Settings 를 클릭합니다. Photo parameters tab 을 클릭합니다. 
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2. 스냅 샷 선명도를 설정합니다. 

3. Save 를 클릭합니다. 

Detection Parameters 

 

NOTE! 

 일부 카메라 모델에서만 고급 설정을 지원합니다. 자세한 내용은 실제 웹 인터페이스를 

참조하십시오. 

 기본 탐지 모드는 Normal Mode 입니다. 필요에 따라 설정하십시오. 

 

1. Setup > Intelligent > Advanced Settings 을 클릭합니다. Detection parameters tab 을 클릭합니다. 

 

 

2. 탐지 모드를 선택합니다. 감시 환경에서 반복적으로 감지 된 반복적인 알람보고를 방지하려면 

Filter Repeated Motion Mode 을 선택합니다. 

3. Save 을 클릭합니다. 

Common Alarm Configuration 

당신은 알람 리포팅을 스케쥴하고 다른 장치에 의해 트리거될 수있는 동작을 설정하여 알람 및 

트리거된 동작을 제때 처리 할 수 있습니다. 

알람보고는 모션 감지 알람, 알람 입력, 알람 출력, 변조 감지 알람 및 오디오 감지 알람에 대한 스케줄을 

지정할 수 있습니다. 지원되는 알람은 장치 모델에 따라 다를 수 있습니다. 카메라에서 지원하는 알람 

유형은 웹 인터페이스를 참조합니다. 

Configuring Motion Detection Alarm 

움직임 감지는 일정 기간 동안 지정된 사각형 영역에서 물체의 움직임을 감지합니다. 카메라가 모션을 

감지했을 때 모션 감지 알람을보고할지 여부를 결정할 수있는 감지 영역, 탐지 감도, 객체 크기 및 

히스토리를 설정해야 합니다. 
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NOTE! 

 일부 모델에서는이 기능을 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 알람 트리거 조치는 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 

참조하십시오. 

 

Area Detection 

1. Setup > Events > Common Alarm > Motion Detection 을 클릭합니다. Detection Mode 을 Area 로 

설정합니다. 

 

2. Detection Area 영역 내에서,  를 클릭하여 새로운 감지 영역을 추가합니다. 감지 영역을 

삭제하려면 를 클릭합니다. 

3. 마우스로 클릭 및 드래그하여 감지 영역을 설정합니다. 

4. 카메라의 모션 감지 알람을 전송 할 감지 민감도, 객체 크기 및 히스토리를 설정합니다. 

 감지 민감도를 높이려면 슬라이더를 오른쪽으로 이동시킵니다. 감지 영역 내의 동작 범위가 

설정된 객체 크기를 초과하고, 동작 지속 시간이 설정된 지속 시간을 초과하는 경우에 카메라가 

알람을 전송합니다. 

 객체 크기는 알람이 전송되기 전에 전체 감지 영역의 크기에 대한 객체의 크기의 최소 비율을 

지정합니다. 즉, 작은 물체의 움직임을 감지하려면 실제 움직임 영역에 작은 상자 (감지 영역)를 

그려야합니다. 

 움직임 감지 결과가 실시간으로 표시됩니다. 빨간색 선은 모션 감지 알람을 표시합니다. 선이 

길수록 움직임 범위가 넓어집니다. 선들의 밀도가 높을수록 움직임 빈도가 높아집니다. 
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5. 알람 파라메터를 설정합니다. 

 Suppress Alarm(s) : 알람이 트리거 되면 설정된 시간 내에 동일한 알람이 전송되지 않습니다. 

 Clear Alarm(s): 알람이 트리거 된 후, 

a. 설정된 시간 내에 동일한 알람이 트리거 되지 않으면 알람이 지워지고, 동일한 알람을 다시 

전송 할 수 있습니다. 

b. 설정된 시간 내에 동일한 알람이 트리거 되면 Suppress alarm 시간이 만료 될 때까지 알람이 

지워지지 않습니다. 그후에 동일한 알람을 다시 전송 할 수 있습니다. 

6. 움직임 감지 알람 및 계획에 의해 트리거 할 동작을 설정합니다. 

 

다음 표에서는 주요 알람으로 트리거되는 동작과 계획을 설정하는 방법에 대해 설명합니다. 

Item Description 

Alarm 

Output 1 

체크 박스를 선택합니다. 이 설정은 움직임 감지 알람과 연결된 알람 출력 인터페이스 

입니다. 

Note:  

알람이 전송되면, 카메라는 알람 출력을 트리거하여 타사 장치에 의한 발생 동작이 되게 

합니다. 

Goto 
Preset 

체크 박스를 선택하고 움직임 감지 알람과 연결된 프리셋을 설정합니다. 

Note: 

 프리셋이 설정되어 있는지 확인합니다. 그렇지 않으면 이 파라메터를 설정할 수 

없습니다. 프리셋 설정에 대한 자세한 내용은오류! 참조 원본을 찾을 수 없습니다. 을 

참조하십시오. 

 알람이 전송되면, PTZ 카메라가 자동으로 프리셋으로 이동하여 정확한 화면의 비디오를 

캡처할 수 있도록 합니다. 

Upload to 
FTP 

Upload to FTP를 선택하면, 알람이 발생되면 카메라가 지정된 FTP 서버에 스냅샷을 자동으로 

업로드 합니다. 

Note: 

이 기능을 사용하기 전에 FTP 및 Snapshot 설정을 완료했는지 확인합니다. 

Recording 

Recording을 선택하면, 알람이 발생되면 카메라가 자동으로 비디오를 녹화합니다. 

Note: 

먼저 Storage 페이지에서Post-Record(s)를 설정하십시오. Post-Record(s)는 알람이 끝난 후 

녹화가 지속되는 시간을 지정합니다. 

Alarm the 
Center 

Alarm the Center를 선택하면, 카메라는 알람이 트리거 되면 중앙 서버로 알람 정보를 

전송합니다. 
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Note: 

먼저 Server 페이지에서 설정을 완료합니다. 

Trigger 
Tracking 

Trigger Tracking을 선택하면, 카메라가 알람이 트리거 될 때 자동 추적을 시작합니다. 

Note: 

일부 카메라 모델들이 지원하는 기능입니다. 

먼저 Smart Settings 페이지에서 자동 추적을 설정합니다. 

Trigger E-
mail 

Trigger E-mail을 선택하면, 알람이 트리거 되면 카메라가 지정된 전자 메일 주소로 스냅샷을 

자동으로 전송합니다.  

Note: 

이 기능을 사용하기 전에 E-Mail 과 Snapshot 설정 완료했는지 확인합니다.  

Enable Plan 

체크 박스를 선택하고 움직임 감지 알람이 유효한 시작 및 종료 시간을 설정하십시오. 

마우스를 직접 드래그하여 계획을 지정하고 Edit를 클릭하여 테이블의 기간을 편집 할 수 

있습니다. 기간은 중복 될 수 없습니다. 카메라는 지정된 기간 동안에만 알람을 전송합니다. 

월요일부터 일요일까지 선택하고 매일 4 개의 기간을 설정할 수 있습니다. 

 

 

마우스를 드래그하여 계획 지정  테이블의 기간 편집 

Note:  

마우스를 이용하여 계획을 지정하는 작업은 8.0 이후 버전의 Internet Explorer 에서만 

지원됩니다. 하루 동안 계획을 설정 한 후, Copy 및 Paste 를 클릭하여 다른 날에도 동일한 

설정을 적용할 수 있습니다. 

 

7. Save 를 클릭합니다. 

Grid Detection 

1. Setup > Events > Motion Detection 를 클릭합니다. Detection Mode 를 Grid 로 설정합니다. 
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2. 감지 영역은 그리드에서 불규칙하게 설정할 수 있습니다. 

3. 카메라의 감지 감도를 설정하여 움직임 감지 알람의 전송 여부를 결정합니다. (알람은 호환되는 

NVR 에서 확인 가능함). 

4. 알람 파라메터를 설정합니다. 

 Suppress Alarm(s) : 알람이 트리거 되면 설정된 시간 내에 동일한 알람이 전송되지 않습니다. 

 Clear Alarm(s): 알람이 트리거 된 후, 

a. 설정된 시간 내에 동일한 알람이 트리거 되지 않으면 알람이 지워지고, 동일한 알람을 다시 

전송 할 수 있습니다. 

b. 설정된 시간 내에 동일한 알람이 트리거 되면 Suppress alarm 시간이 만료 될 때까지 알람이 

지워지지 않습니다. 그후에 동일한 알람을 다시 전송 할 수 있습니다. 

5. 움직임 감지 알람 및 계획에 의해 트리거 할 동작을 설정합니다. 자세한 단계는 Configuring Motion 

Detection Alarm 의 Area Detection 에서 알람 발생 동작에 대한 설명을 참조하십시오. 

6. Save 를 클릭합니다. 

Configuring Tampering Alarm 

카메라의 렌즈가 일정 시간 차단 된 경우 템퍼링 알람을 전송하도록 구성합니다. 

 

NOTE! 

 이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 알람 트리거 동작은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 

참조하십시오. 

 

1. Setup > Events > Common Alarm >Tampering Alarm 을 클릭합니다. 
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2. Tampering Alarm 의 On 을 선택합니다. 

3. 카메라가 템퍼링 알람을 전송할지 여부를 결정할 감지 감도 및 지속 시간을 설정합니다. 감도는 

세 가지 레벨로 나뉩니다: 상위 레벨, 중간 레벨 및 하위 레벨. 중간 레벨 감도와 비교하여 카메라는 

감도가 높게 설정된 경우 멀리 떨어진 곳에서 차단을 감지 할 수 있습니다. 카메라가 지정된 시간 

동안 렌즈가 차단되면 알람이 전송됩니다. 

템퍼링 알람은 전체 화면에 효과적입니다. 템퍼링 알람을 비활성화 하려면 Tampering Alarm 체크 

박스에서 Off 를 선택합니다. 

4. 템퍼링 알람 및 계획에 의해 트리거 할 동작을 설정합니다. 자세한 단계는 Configuring Motion 

Detection Alarm 의 알람 트리거 동작에 대한 설명을 참조하십시오. 

5. Save 를 클릭합니다. 

Configuring Audio Detection Alarm 

카메라는 오디오 입력 신호에 대한 예외를 감지 할 수 있습니다. 음량의 상승 또는 하강이 설정 한도를 

초과하거나, 입력 음량이 임계값에 도달하면 카메라는 알람을 전송하고 설정된 동작을 트리거 합니다. 

오디오 입력 장치가 카메라에 올바르게 연결되어 있고, 오디오 입력이오류! 참조 원본을 찾을 수 

없습니다.에서 켜져 있는지 확인하십시오. 

 

NOTE! 

 이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 웹 인터페이스를 참조하십시오.  

 알람 트리거 동작은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 

참조하십시오. 

 

1. Setup > Events > Common Alarm >Audio Detection 을 클릭합니다. 
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2. Audio Detection 의 Enable 을 선택하고, 감지 유형을 선택하고 차이 또는 임계 값을 설정합니다. 

오디오 감지를 사용하지 않으려면 Enable 체크 박스를 해제합니다. 

다음 표에서는 몇 가지 주요 파라메터를 설명합니다. 

Parameter Description 

Detection 
Type 

 Sudden Rise: 음량 상승이 차이를 초과하면 알람이 전송됩니다. 

 Sudden Falls: 음량 하강이 차이를 초과하면 알람이 전송됩니다. 

 Sudden Change: 음량의 상승 또는 하강이 차이를 초과하면 알람이 전송됩니다. 

 Threshold: 음량이 임계값을 초과하면 알람이 전송됩니다. 

Difference 

 Threshold: 음량을 임계값으로 설정한 후, 임계값을 초과하면 알람이 전송됩니다. 

 Difference: 두 음량의 차이. 음량의 상승 또는 하강이 차이를 초과하면 알람이 

전송됩니다. 

Note: 

 오디오 감지 영역의 스케일은 소리의 음량을 측정하는데 사용됩니다. 

 오디오 감지 결과는 실시간으로 표시됩니다. 빨간색 부분은 전송된 오디오 감지 

알람을 나타냅니다. 

 

ScaleVolume
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Parameter Description 

 

 

3. 필요에 따라 알람으로 트리거 되는 동작 및 준비 일정을 설정합니다. 자세한 단계는 Configuring 

Motion Detection Alarm 의 알람 트리거 동작에 대한 설명을 참조하십시오. 

4. Save 를 클릭합니다. 

Configuring Alarm Input 

카메라는 타사 장치에서 알람 정보를 수신할 수 있습니다. 이 기능을 사용하려면 알람 입력에 포트, 

알람 이름, 알람 유형 (일반적으로 N.O. 또는 N.C. 타입) 및 알람 전송 시간과 같은 정보를 설정해야 

합니다. 

 

NOTE!  

 이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 알람 트리거 동작은 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 웹 인터페이스를 

참조하십시오. 

 

1. Setup > Events > Common Alarm > Alarm Input 을 클릭합니다. 

Difference
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2. 알람을 선택하고 알람 이름을 설정합니다. 

3. Alarm type 에서 타사 알람 입력 장치 타입에 따라 N.O. 또는 N.C.를 선택하십시오. 예를 들어, 

타사 알람 입력 장치 타입이 노멀 오픈이면, 카메라가 타사 알람 입력 장치로부터 제대로 알람 

정보를 받을 수 있도록 N.O.을 선택해야 합니다. 

4. 알람 입력 및 계획에 의해 트리거 될 동작을 설정하십시오. 자세한 단계는 Configuring Motion 

Detection Alarm 의 알람 트리거 동작에 대한 설명을 참조하십시오. 

5. Save 를 클릭합니다. 

Configuring Alarm Output 

알람 출력이 모션 감지 알람, 부울 알람에 의해 트리거 된 후 알람 출력이 노멀 오픈 또는 노멀 클로즈로 

설정되면 카메라는 알람 정보를 타사 장치로 출력 할 수 있습니다. 알람 출력 지속 시간은 설정 

가능합니다. 

 

NOTE! 

이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Setup > Events > Common Alarm > Alarm Output 을 클릭합니다. 
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2. 알람을 선택하고 알람 이름을 설정합니다. 

3. 상태를 N.O. (기본 설정) 로 설정하고, 알람 지속 시간을 설정합니다. 

4. 입력 알람 및 계획에 의해 트리거 될 동작을 설정합니다. 자세한 단계는 Configuring Motion 

Detection Alarm 의 알람 트리거 동작에 대한 설명을 참조하십시오. 

5. Save 를 클릭합니다. 

 

CAUTION! 

카메라 부품의 손상을 방지하려면 장치의 전원을 켤 때 다음의 순서를 엄수하십시오:  

1. 알람 타입이 노멀 오픈 (기본 설정) 으로 설정되어 있고, 카메라와 알람 출력 장치의 전원이 꺼져 

있는지 확인하십시오.  

2. 연결이 완료되면, 먼저 카메라 전원을 켜고 알람 출력 장치의 전원을 켭니다. 

 

Memory Card Storage 

 
NOTE! 

 이 기능은 일부 모델에서는 지원되지 않으며, 모델에 따라 다를 수 있습니다. 자세한 내용은 실제 

모델을 참조하십시오. 

 카메라가 스탠드얼론형 모드로 동작되는 경우 Edge Storage 사용을 권장합니다. 중앙 관리 서버에서 

카메라를 관리하는 경우, 캐시 포스트 레코딩 서비스에 영향을 미치지 않도록 Edge Storage 를 

중지해야합니다. 
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Setting Edge Storage 

Edge storage 는 비디오 데이터와 스냅샷을 메모리 카드에 직접 저장하는데 사용됩니다. 카메라를 

스탠드얼론형 모드로 동작되는 경우 Edge storage 사용을 권장합니다. 

Manual storage 

Manual storage 가 활성화된 경우 카메라는 반복적으로 라이브 비디오를 녹화 합니다. 

1. Setup > Storage > Storage 를 클릭합니다. 

 

일부 모델의 카메라에서는 페이지가 다음과 같이 표시됩니다. 

 

2. Edge Storage 를 시작하고 필요에 따라 설정을 수정하십시오. 다음 표는 몇 가지 주요 파라메터를 

설명합니다. 

Parameter Description 

Storage 
Medium 

스토리지 자원 타입. 
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Note: 

 메모리 카드를 포맷하려면 먼저 카드의 저장 기능을 비활성화 하십시오. 그런 

다음 Format 을 클릭하고 OK 를 클릭하십시오. 포맷이 완료되면 시스템이 다시 

시작됩니다. 

 전체 및 여유 공간에 대한 정보가 표시됩니다. 

Data 
Overwrite 
Policy 

 Overwrite: 메모리 카드에 여유 공간이 없으면, 새 데이터가 기존 데이터를 반복해서 

덮어 씁니다. 

 Stop: 메모리 카드에 여유 공간이 없으면, 새 데이터가 메모리 카드에 저장되지 

않습니다. 

Post-Record(s) 알람으로 트리거 된 레코딩의 경우, 알람이 끝난 후 레코딩이 지속되는 시간. 

 

3. Save 를 클릭합니다. 

Planned storage 

Planned Storage 가 활성화 된 경우, 카메라는 지정된 기간 동안 비디오를 메모리 카드에 녹화합니다. 

1. Setup > Storage > Storage 를 클릭합니다. 

 

일부 모델의 카메라에서는 페이지가 다음과 같이 표시됩니다. 
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2. Planned Storage 를 선택하고, 카메라가 비디오를 메모리 카드에 녹화하는 기간을 설정합니다. 

3. Save 를 클릭합니다. 

 
NOTE!  

 Planned storage 와 Manual storage 는 동시에 활성화 할 수 없습니다. 

 메모리 카드의 레코딩은 오류! 참조 원본을 찾을 수 없습니다.를 참조하십시오. 

 

Setting Cache Post Recording 

중앙 관리하에 있는 카메라는 메모리 카드를 중앙 관리 서버의 백업 저장소 리소스로 사용할 수 

있습니다. 불안정한 네트워크 연결로 인해 카메라에서 중앙 저장 장치로 저장이 중단되면, 카메라는 

자동으로 캐시 포스트 레코딩을 시작하고, 비디오를 메모리 카드에 저장합니다. 

녹화 백업 기능을 사용하면, 카메라와 백업 서버 간의 통신이 복원 될 때 카메라는 메모리 카드에 

저장된 비디오를 파일 형식으로 백업 서버의 저장 장치 리소스로 자동 전송할 수 있습니다.  



53 

 
NOTE! 

카메라의 캐시 포스트 레코딩을 설정하기 전에 다음 사항을 확인하십시오: 

 메모리 카드가 카메라에 올바르게 설치되어 있어야 합니다. 

 백업 리소스가 중앙 서버에 추가되도록 합니다. 

 백업 리소스가 카메라에 할당되도록 합니다. 

 

Disable edge storage 

1. Setup > Storage > Storage 를 클릭합니다. 

 

일부 모델의 카메라에서는 페이지가 다음과 같이 표시됩니다. 

 

2. Edge Storage 를 Disable (Manual storage 를 비활성화) 로 설정하고, 비디오 용량을 설정합니다. 

3. Save 를 클릭합니다. 
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System Maintenance 

 
NOTE!  

이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

Security 

User Management 

시스템에는 두 가지 타입의 사용자가 있습니다: 

 Administrator: 이 설명서에서는 "admin" 이라고 합니다. Administrator 의 기본 이름은 admin 이며 

수정할 수 없습니다. Admin 은 모든 권한을 가지고 있으며 모든 사용자 및 장치를 관리 할 수 

있습니다. 시스템에서는 한 명의 관리자만 허용됩니다. 

 Common user: 이 설명서에서 " user " 라고 합니다. User 는 라이브 및 녹화 된 비디오를 재생할 수 

있는 권한만 가지고 있습니다. 최대 32 명의 common user 가 시스템에 허용됩니다. 

사용자 관리 인터페이스 (Setup > Security > User 아래) 에서 user 를 추가 할 수 있습니다. 

User 가 성공적으로 추가되면, 새 암호를 입력하여 암호를 변경하거나 username 을 지워 user 를 삭제할 

수 있습니다. 

 
NOTE! 

 Admin 만이 암호를 변경할 수 있습니다. User 가 아직 로그인되어 있을 때 user 의 username 

이나 password를 변경하면 강제로 user가 로그아웃 됩니다. User는 새로운 username 또는 password를 

사용하여 로그인해야 합니다 

 Admin 만이 user 를 추가 및 삭제할 수 있습니다. User 가 로그인 중인데 user 를 삭제하면 강제로 로그 

아웃됩니다. 삭제 된 user 는 로그인 할 수 없습니다. 

 

Setting Secure Data Transmission 

보안을 위해 데이터 전송을 위한 보안 채널을 설정합니다. 

 
NOTE!  

이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Setup > Network > Port 를 클릭합니다. 

 

2. HTTPS Port 텍스트 박스에 포트 번호를 입력하십시오. 

3. Save 를 클릭합니다. 

4. Setup > Security > Network Security > HTTPS 를 클릭합니다. 
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5. HTTPS 의 On 을 선택합니다. 필요에 따라 사용자 정의 SSL Certificate 를 가져올 수 있습니다. 

6. Save 를 클릭합니다. 

다음에 로그인 할 때, 주소를 https://IP:HTTPS 포트 번호 형식 (예: https://192.168.0.13:443) 으로 

입력하여 보안 채널 모드를 시작합니다. 기본 HTTPS 포트를 사용하는 경우 https://IP 를 입력합니다. 

RTSP Authentication  

RTSP (Real Time Streaming Protocol) 는 어플리케이션 레이어 프로토콜 입니다. 오디오 및 비디오를 

전송하고 제어하려면, 웹 인터페이스에서 RTSP 인증을 설정합니다. 

1. Setup > Security > Network Security > RTSP Authentication 를 클릭합니다. 

 

2. 인증 모드 (Basic/Digest) 를 선택하고 Save 를 클릭합니다. 

Hide Vendor Information 

웹 인터페이스에서 네트워크 카메라의 공급 업체 정보를 숨기도록 설정할 수 있습니다. 

1. Setup > Security > Registration Info 를 클릭합니다. 

 

2. Registration Info 에서 On 을 선택합니다. 

APR Binding 

이 기능은 ARP 공격으로부터 카메라를 보호 할 수 있습니다. 카메라가 게이트웨이를 통해 다른 

네트워크 세그먼트의 IP 를 방문하면, 동일한 세그먼트의 게이트웨이 주소에 바인딩 된 MAC 주소와 만 

통신 할 수 있습니다. 

1. Setup > Security > Network Security > ARP Protection 을 클릭합니다. 

 

2. 체크 박스를 선택하여 ARP 바인딩 기능을 활성화하고 게이트웨이 MAC 주소를 설정합니다 

3. Save 를 클릭합니다. 

IP Address Filtering 

지정된 IP 주소에서 액세스를 허용하거나 금지하려면 IP address filtering 을 사용하십시오. 
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NOTE!  

이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Setup > Security > Network Security > IP Address Filtering 를 클릭합니다. 

 

2. On 을 선택하여 IP address filtering 을 활성화 합니다. 

3. Filtering mode 를 선택하고, IP 주소를 추가합니다. 

4. Save 를 클릭합니다. 

 
NOTE! 

 Filtering Mode 가 Whitelist 로 설정된 경우, 추가 된 IP 주소 만 카메라에 액세스 할 수 있습니다. Filtering 

Mode 가 Blacklist 로 설정된 경우, 추가 된 IP 주소 만 카메라에 액세스 할 수 없습니다. 

 최대 32 개의 IP 주소가 허용됩니다. 각 IP 주소는 한 번만 추가 할 수 있습니다. 

 각 IP 주소의 첫 번째 바이트는 1-223 이어야 하며, 네 번째 바이트는 0 이 될 수 없습니다. 예를 들어, 

다음 IP 주소는 잘못되어 추가 할 수 없습니다: 0.0.0.0, 127.0.0.1, 255.255.255.255, 224.0.0.1. 

 

Access Policy 

 
NOTE! 

Friendly password 를 사용하더라도 사용에는 영향을주지 않습니다. 이 기능을 끄고 weak password 로 

로그인하면, 페이지가 팝업되어 암호를 변경하라는 메시지가 표시됩니다. 이 페이지에는 Cancel 

또는 Close 버튼이 없습니다. 기본 password 는 weak 로 처리됩니다. 

 

1. Setup > Security > Network Security > Access Policy 를 클릭합니다. 

 

2. Telnet 을 사용하려면 On 을 선택하고, friendly password 를 사용하려면 Enable 을 선택합니다. 

3. Save 를 클릭합니다. 
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Watermark 

워터마크를 사용하여 비디오와 함께 사용자 정의 정보를 암호화하여 권한이 없는 삭제 또는 변경을 

방지합니다. 

 
NOTE! 

이 기능은 일부 카메라 모델 만이 지원합니다. 

 

1. Setup > Security > Watermark 를 클릭합니다. 

 

2. 워터마크를 활성화하려면 On 을 선택하고, 워터마크 컨텐츠를 입력합니다. 

3. Save 를 클릭합니다. 

Setting the System Time 

다음 방법을 사용하여 장치의 시스템 시간을 설정할 수 있습니다. 

Manually Setting or Synchronizing the System Time 

1. Setup > Common > Time 을 클릭하고, Time 탭을 클릭합니다. 

  

2. Sync Mode 를 선택합니다. 

3. 올바른 Time Zone 와 System Time 을 설정합니다. Sync with Computer Time 을 클릭하여 카메라의 

시간 설정을 PC 의 시간 설정과 동기화 할 수도 있습니다. 

4. Save 를 클릭합니다. 

Synchronizing with the NTP Server 

1. Setup > Common > Time 을 클릭하고, Time 탭을 클릭합니다. 

 

2. Sync Mode 를 Sync with NTP Server 로 설정하고, NTP 서버의 IP 주소와 Update Interval 을 

설정합니다. 

3. Save 를 클릭합니다. 카메라가 주기적으로 NTP 서버와 시간을 동기화합니다. 
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Setting the DST 

1. Setup > Common > Time 을 클릭하고, DST 탭을 클릭합니다. 

 

2. DST 의 On 을 선택하고, Start Time, End Time, DST Bias 를 설정합니다. 

3. Save 를 클릭합니다. 

Setting Servers 

Intelligent Server 

민감한 카메라를 중앙 서버에서 관리하는 경우 지능형 서버를 구성해야합니다. 

 
NOTE! 

 일부 카메라 모델만 지능형 서버를 지원합니다. 

 얼굴 스냅샷을 사용하려면, 스냅샷이 업로드 될 TMS 서버를 구성해야합니다. 

 

1. Setup > Common > Server 를 클릭하고, Intelligent Server 탭을 클릭합니다. 

 

2. TMS 서버의 IP 주소를 설정하고, 다른 설정들을 완료합니다. 

3. Save 를 클릭합니다. 

Serial Port Mode Configuration 

RS485 시리얼 포트는 타사 장치와의 데이터 통신에 사용됩니다. 카메라의 시리얼 포트 설정은 연결된 

타사 장치의 설정과 일치해야 합니다. 

 
NOTE! 

이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

PTZ control 

타사 장치를 통해 PTZ 카메라를 제어하려면, Port Mode 를 PTZ Control 로 설정해야합니다. 

PELCO-D 호환 PTZ 제어 명령을 RS485 포트를 통해 전송함으로서, PTZ 제어 패널을 사용하지 않고도 PTZ 

카메라를 제어 할 수 있습니다. 
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1. Setup > System > Ports & Devices 를 클릭하고, Serial Port 탭을 클릭합니다. 

  

2. Port Mode 에서 PTZ Control 을 선택합니다. 다음 표는 몇 가지 주요 파라메터를 설명합니다. 

Parameter Description 

PTZ Protocol 

채널이 지원하는PTZ 프로토콜을 설정합니다. 

Note: 

 Port Mode 가 PTZ Control 로 설정된 경우에만 이 파라메터를 설정할 수 있습니다.  

 PTZ Protocol 을 INTERNAL-PTZ 로 설정하면, 카메라는 시리얼 포트를 사용하지 않고 

외부 PTZ 에 연결할 수 있습니다 (시리얼 포트 파라케터는 회색으로 표시됩니다). 이 

경우, 카메라의 줌 및 포커스 인터페이스를 렌즈에 연결하기만 하면 내부 PTZ 처럼 

PTZ 를 조작 할 수 있습니다. 

PTZ Mode 

 Built-in PTZ Priority: 이 옵션을 선택하면, 카메라가 먼저 외부 PTZ 대신 PTZ (예: 줌 

또는 포커스) 를 제어하려고 시도합니다. 카메라가 자체적으로 수행 할 수 없는 

작업의 경우 카메라는 외부 PTZ 를 사용합니다. 

 External PTZ Priority: 카메라는 먼저 시리얼 포트를 통해 연결된 PTZ 를 통해 PTZ 를 

제어하려고 시도합니다. 

Note: 

 Port Mode 가 PTZ Control 로 설정된 경우에만 이 파라메터를 설정할 수 있습니다. 

 INTERNAL-PTZ 를 선택하면 이 파라메터는 항상 Built-in PTZ Priority 로 설정되며, 

시리얼 포트를 통해 카메라를 외부 PTZ 에 연결할 필요가 없습니다. 외부 PTZ 를 통한 

제어는 카메라가 외부 PTZ 에 연결되어 있어도 효과가 없습니다. 

 이 파라메터는 필요에 따라 설정합니다. PTZ 제어 관련 인터페이스가 올바르게 

연결되어 있는지 확인합니다. 

Address Code 

PTZ의 주소 코드를 설정합니다. 

Note: 

Port Mode 가 PTZ Control 로 설정되어 있고, PTZ Control 이 INTERNAL-PTZ 로 설정되지 

않은 경우에만 이 파라메터를 설정할 수 있습니다.  
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3. Save 를 클릭합니다. 

Transparent channel 

타사 장치와의 트랜스패런트 데이터 전송을 위해 RS485 시리얼 포트를 사용합니다. 트랜스패런트 

채널은 주로 두 장치 간 트랜스패런트 데이터 전송을 위해 사용됩니다. 

 

 
NOTE!  

 이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 카메라의 Port Mode 를 Trans-Channel 로 설정했는지 확인하십시오. 

 

1. Setup > System > Ports & Devices 를 클릭하시고, Serial Port 탭을 클릭합니다. 

 

2. Port Mode 목록에서 Trans-Channel 를 선택합니다. 

3. Enable Trans-Channel 체크박스를 선택합니다. 

4. Destination IP 주소 및 Destination Port 번호 (Transparent Channel 이 연결되는 IP 주소 및 포트 번호) 

를 입력합니다. 

5. Save 를 클릭합니다. 

OSD 

타사 장치의 정보를 OSD 에 표시하려면, OSD 를 포트 모드로 선택해야 합니다. 

카메라는 RS485 시리얼 포트를 통해 타사 장치에서 정보를 수신하고, 수신 된 정보를 변환하여 OSD 에 

표시합니다. 

 
NOTE! 

카메라가 타사 장치에서 받은 정보를 올바르게 변환할 수 있게 하려면, 타사 장치가 시리얼 포트를 

통해 보낸 정보가 당사에서 지정한 데이터 형식을 준수하는지 확인하십시오. 자세한 내용은 대리점에 

문의하십시오. 
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1. Setup > System > Ports & Devices 를 클릭하고, Serial Port 탭을 클릭합니다. 

 

2. Port Mode 목록에서 OSD 를 선택합니다. Enable OSD Report (OSD 데이터가 플랫폼에 업로드 

되도록) 를 선택합니다. 

3. Save 를 클릭합니다. 

ONVIF Transparent Channel 

카메라의 RS485 포트와 타사 장치 사이의 Transparent Channel (ONVIF) 을 통해 데이터를 전송합니다. 

1. Setup > System > Ports & Devices 를 클릭하시고, Serial Port 탭을 클릭합니다. 

 

2. Port Mode 를 Select Trans-Channel via ONVIF 로 설정합니다. 

3. Save 를 클릭합니다. 

Wiper Control 

와이퍼를 제어하기 전에 와이퍼 파라메터를 설정합니다. 

 
NOTE!  

이 기능은 일부 모델에서는 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Setup > System > Ports & Devices 를 클릭하시고, External Device 탭을 클릭합니다. 
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2. 와이퍼의 제어 모드를 설정합니다. 다음 표는 몇 가지 주요 파라메터를 설명합니다. 

Parameter Description 

Serial Port 
와이퍼는 PELCO-D 명령에 의해 제어됩니다. 따라서, PTZ 프로토콜을 PELCO-D로 

설정해야 합니다. 자세한 내용은 오류! 참조 원본을 찾을 수 없습니다.을 참조하십시오. 

Alarm 
Input/Output 

알람 입력 및 출력을 사용하여 회로를 열거나 닫고 와이퍼를 제어합니다. 

 

Viewing Device Status 

카메라의 현재 상태를 볼 수 있습니다. 

1. Setup > Common > Basic Info 를 클릭합니다. 

2. Refresh 를 클릭하여, 최신 상태 정보로 업데이트 합니다. 

3. 장치 정보를 확인합니다. 

Photo Storage Status 

현재 사진 저장 상태를 확인합니다. 전체 스토리지 정책은오류! 참조 원본을 찾을 수 없습니다.를 

참조하십시오. 

 
NOTE!  

저장 기능이 있는 모델만이 기능을 지원합니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Photo 를 클릭합니다. 
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2. Refresh 를 클릭하여 저장 상태를 업데이트 합니다. 

3. Image List 영역에서 사진을 내보내기 또는 삭제할 수 있습니다. 

Upgrading the Device 

장치가 중앙 관리 서버에 의해 관리되고 일괄 처리 모드로 장치를 업그레이드 하려는 경우, 중앙 

서버에서 업그레이드 작업을 수행하는 것이 좋습니다. 자세한 단계는, 중앙 관리 서버의 사용자 

설명서를 참조하십시오. 

1. Setup > System > Maintenance 를 클릭합니다. 

 

2. Software Upgrade 에서, Browse 를 클릭하고, 올바른 업그레이드 파일을 선택합니다. 

3. Upgrade 를 클릭하고 확인하여 시작하십시오. 업그레이드가 완료되면 카메라가 자동으로 다시 

시작 됩니다. 

4. Detect 를 클릭하여 클라우드 업그레이드에서 사용할 수 있는 새 버전을 확인할 수 있습니다. 
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NOTE! 

 카메라의 올바른 업그레이드 파일을 사용해야 합니다. 그렇지 않으면, 예기치 않은 결과가 발생할 수 

있습니다. 

 업그레이드 파일은 ZIP 파일이며 모든 필요한 파일을 포함해야 합니다. 

 부팅 프로그램이 운영 체제를 로드하면 시스템이 실행되기 시작합니다. 업그레이드 부팅 프로그램 

기능은 기본적으로 비활성화되어 있으며 카메라만 최신 버전으로 업그레이드 됩니다. 활성화되록 

설정하면, 카메라와 부팅 프로그램이 모두 업그레이드 되며, 다음 새 버전의 운영 체제를 올바르게 

부팅 할 수 있으며 카메라를 편리하게 업그레이드 할 수 있습니다. 

 업그레이드하는 동안 전원이 정상적으로 공급되도록 유지 하십시오. 업그레이드가 완료되면 장치가 

다시 시작됩니다. 

 

Restarting the System 

1. Setup > System > Maintenance 를 클릭합니다. 

 

2. Device Restart 에서, Restart 를 클릭합니다. 동작을 확인하면 장치가 다시 시작됩니다.  

 
CAUTION! 

시스템을 다시 시작하면 진행중인 서비스가 중단되므로 이 작업을 신중하게 수행하십시오. 

 

Importing and Exporting System Configuration File 

카메라의 현재 설정을 내보내 PC 또는 외부 저장 매체에 저장하십시오. 또한, PC 또는 외부 저장 매체에 

저장된 백업 설정을 카메라로 가져 와서 설정을 신속하게 복원할 수 있습니다 

 
CAUTION!  

 Default 작업을 수행하면 시스템 administrator 의 로그인 암호, 네트워크 설정 및 시스템 시간을 제외한 

모든 설정이 제조시 기본값으로 복원됩니다. 

 카메라에 맞는 올바른 설정 파일을 가져와야합니다. 그렇지 않으면, 예기치 않은 결과가 발생할 수 

있습니다. 

 설정 파일을 성공적으로 가져오면 카메라가 다시 시작됩니다. 

 

1. Setup > System > Maintenance 를 클릭합니다. 
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2. 백업 한 설정을 가져 오려면, Import 버튼 옆에 있는 Browse 를 클릭하고, 가져올 설정을 선택한 

다음 Import 를 클릭합니다. 결과가 표시됩니다. 

3. 설정을 내보내려면, Export 를 클릭하고 대상 폴더를 선택합니다. 

4. 기본 설정을 복원하려면, Default 를 클릭하고 확인하십시오. 장치가 다시 시작되고 기본 설정이 

복원됩니다. 

Collecting Diagnosis Information 

진단 정보에는 로그 및 시스템 설정이 포함됩니다. 진단 정보를 PC 로 내보낼 수 있습니다. 

1. Setup > System > Maintenance 를 클릭합니다. 

 

2. Diagnosis Info 의, Export 를 클릭하고 대상 폴더를 선택합니다. 

 
NOTE! 

 진단 정보는 압축 파일 형식으로 로컬 폴더로 보내집니다. WinRAR 와 같은 도구를 사용하여 파일의 

압축을 풀고 텍스트 편집기를 사용하여 파일을 열어야 합니다. 

 Collect Image Debugging Info 를 선택하면, 디버깅 정보가 있는 비디오를 동시에 표시할 수 있으므로 

문제 해결이 용이합니다. 

Focus Configuration 

장치는 최소초점 거리에 따라 자동초점 속도를 조정할 수 있습니다. 선명한 물체를 촬영하려면, 

최소초점 거리가 물체와 렌즈 사이의 거리보다 짧게 설정하는 것이 좋습니다. 예를 들어, 최소초점 

거리가 3m 이면 렌즈에서 3m 이내의 물체는 초점에서 벗어납니다. 

 
NOTE! 

이 기능은 자동초점 기능이 있는 장치에서만 지원됩니다. 자세한 내용은 실제 모델을 참조하십시오. 

1. Setup > System > Maintenance 를 클릭합니다. 

 

2. Focus 의, Min. Focus Distance (단위: cm) 와 Max. Zoom Ratio 를 설정합니다. 

3. OK 를 클릭합니다. 
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Device Mounting Height 

설치된 적외선 돔에서 지면까지의 실제 높이를 입력하면, 돔이 자동으로 적외선 램프를 조정할 수 

있습니다. 

 
NOTE! 

이 기능은 일부 적외선 카메라에서만 지원됩니다. 자세한 내용은 실제 모델을 참조하십시오. 

1. Setup > System > Maintenance 를 클릭합니다. 

 

2. 설치된 적외선 돔에서 지상까지의 실제 높이를 입력합니다. 

3. OK 를 클릭합니다. 

Fisheye Camera Parameter 

비디오를 올바르게 표시하려면, 실제 장착 모드에 따라 어안 파라메터를 올바르게 설정해야 합니다. 

 
NOTE! 

이 기능은 어안 카메라에서만 지원됩니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Live View > Mount 를 클릭합니다. 장착 모드를 선택하십시오. 선택한 장착 모드는 실제 장착 

모드와 일치해야 합니다. 

 

일부 카메라 모델의 경우, 페이지가 다음과 같이 표시됩니다. 
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2. 파라메터를 설정하십시오. 다음 표는 몇 가지 주요 파라메터를 설명합니다. 

Parameter Description 

 

 

 

 

 

 

 

 

 

 

 

11 가지 디스플레이 모드: 

 원본 이미지 

 Panoramic 

 Panoramic+3PTZ 

 Panoramic+4PTZ 

 Panoramic+8PTZ 

 360°Panoramic+1PTZ 

 180°Panoramic 

 Fisheye+3PTZ 

 Fisheye+4PTZ 

 360°Panoramic+6PTZ 

 Fisheye+8PTZ 

 

 

 

3가지 장착 모드: 

• 천장 

• 벽 

• 데스크탑 

Note: 

선택한 장착 모드는 실제 장착 모드와 일치해야 합니다. 
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4  Live View 

라이브 뷰는 카메라에서 웹 인터페이스를 통해 윈도우에서 수신 한 실시간 비디오 (실시간 오디오 및 

비디오) 를 재생하는 것을 의미합니다. 

Live View 체크 박스를 선택하여 로그인하면, 로그인 할 때 라이브 비디오가 기본적으로 

나타납니다 .이 윈도우를 더블 클릭하여 전체 화면 모드를 시작하거나 종료 할 수 있습니다. 

 

 

Live View Toolbar 

 
NOTE! 

지원되는 라이브 뷰 동작은 카메라 모델에 따라 다를 수 있습니다. 카메라가 지원하는 동작에 

대해서는, 웹 인터페이스를 참조하십시오. 

 

Button Description 

/  라이브 비디오 재생 / 정지. 

 

PC에서 미디어 플레이어 출력 음량 조정. 

 

PC와 카메라 간의 오디오 통신 중에 PC의 마이크 음량 조정. 

 

PC에 표시된 현재 이미지의 스냅샷 캡쳐. 

Note:  

스냅샷 저장 경로는 System Configuration 에서 설정합니다.  

/  

로컬 레코딩 시작 / 중지. 

Note:  

로컬 레코딩 저장 경로는 System Configuration 에서 설정합니다. 
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Button Description 

/  PC와 카메라 간의 오디오 통신 시작 / 중지. 

/  
디지털 줌 시작 / 중지. 자세한 내용은 오류! 참조 원본을 찾을 수 

없습니다.을 참조하십시오. 

/  영역 포커스 시작 / 정지. 자세한 내용은Using Area Focus을 참조하십시오. 

/  
3D 포지셔닝 시작 / 정지. 자세한 내용은 오류! 참조 원본을 찾을 수 

없습니다.을 참조하십시오. 

 PTZ 제어판 표시 / 숨김. 

 

윈도우에서 이미지 표시 비율을 설정합니다. 예를 들어, 원본 16:9 에 

고화질 이미지를 표시하려면 Scale을 선택합니다. 윈도우 크기에 따라 

표시하려면 Stretch를 선택합니다. 원본 이미지 크기로 표시하려면 

Original을 선택합니다. 

 

패킷 손실률을 0으로 리셋 합니다. 

Note:  

라이브 뷰 윈도우에서 마우스 커서를 움직이면, 이 버튼이 플로팅 툴바에 

나타납니다. 

 

윈도우 하단에 패킷 손실률 및 비트 전송률 정보를 표시합니다. 

Note: 

라이브 뷰 윈도우에서 마우스 커서를 움직이면, 이 버튼이 플로팅 툴바에 

나타납니다. 

정보를 항상 표시하려면 이 버튼을 클릭합니다. 마우스 커서를 윈도우 

위로 이동하거나 하단에 놓을 때만 정보를 나타납니다. 마우스 커서가 약 

3 초 동안 윈도우에 있거나, 윈도우를 벗어나면 정보가 사라집니다. 

 
이 버튼을 클릭하면 이미지 설정 페이지가 열립니다.  

 
전체 화면 모드로 표시. 

 

 

 

카메라가 지원하는 라이브 비디오 스트림을 선택: 메인 스트림, 서브 

스트림 또는 3번째 스트림. 

 

Viewing Certain Area of Images 

디지털 줌, 영역 초점 및 3D 포지셔닝을 통해 이미지의 특정부분에 대한 세부정보를 얻을 수 있습니다. 

디지털 줌은 화질 손실로 이미지를 확대하는 반면, 3D 포지셔닝은 화질 손실없이 이미지를 

확대합니다. 
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Using Digital Zoom 

 
NOTE! 

지원되는 라이브 뷰 동작은 카메라 모델에 따라 다를 수 있습니다. 카메라가 지원하는 동작에 

대해서는 웹 인터페이스를 참조하십시오. 

 

1. Live View 페이지의 툴바에서 을 클릭합니다. 

 

2. 마우스 버튼을 누른 상태에서, 위에서 아래로 드래그 (직사각형 그리기) 하여 영역을 지정합니다. 

원본 이미지 크기를 복원하고 이미지의 다른 영역을 확대하려면 마우스 오른쪽 버튼을 

클릭합니다. 

3. 종료하려면 을 클릭합니다. 

Using Area Focus 

 
NOTE! 

지원되는 라이브 뷰 동작은 카메라 모델에 따라 다를 수 있습니다. 카메라가 지원하는 동작에 

대해서는 웹 인터페이스를 참조하십시오. 

 

1. Live View 페이지의 툴바에서 을 클릭합니다. 
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2. 마우스 버튼을 누른 상태에서, 위에서 아래로 드래그 (직사각형 그리기) 하여 영역을 지정합니다. 

3. 종료하려면 을 클릭합니다. 

Using 3D Positioning 

 
NOTE! 

이 기능은 모터라이즈드 줌 렌즈와 PTZ 가 장착 된 네트워크 PTZ 카메라와 네트워크 박스 

카메라에서만 사용할 수 있습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

1. Live View 페이지의 툴바에서 을 클릭합니다. 

 

2. 마우스 버튼을 누른 상태에서, 위에서 아래로 드래그 (직사각형 그리기) 하여 영역을 지정합니다. 

반대로 (위에서 아래로) 끌면 축소됩니다. 
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3. 종료하려면 을 클릭합니다. 

Live View of Fisheye Cameras 

 

NOTE! 

 이 기능은 네트워크 어안 카메라에서만 지원됩니다. 자세한 내용은 실제 모델을 참조하십시오. 

 웹의 미리보기 이미지는 카메라의 어안 설정에 따라 다를 수 있습니다. 라이브 뷰를 시작하기 전에 

어안 파라메터 (Fisheye Cameras Parameter 참조) 및 어안 모드 (Video Configuration 참조) 를 

설정하십시오.  

디스플레이 모드에는 원본 이미지, 어안 및 PTZ, Panoramic 및 PTZ 의 세 가지 주요 유형이 있습니다. 

다른 장착 모드에서는 이미지가 다르게 표시됩니다. 다음은 벽 장착을 예로 들어 설명합니다. 

원본 이미지를 선택하면, 어안 이미지가 다음과 같이 표시됩니다. 

 

Panoramic 이 선택되면, 디워프된 파노라마 이미지가 다음과 같이 표시됩니다. 
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NOTE! 

천장 마운트 또는 데스크탑 마운트를 사용하는 경우 파노라마 이미지 (두 개의 180° 이미지) 는 어안 

미리보기 이미지 (360° 이미지) 의 디워프된 이미지입니다. 실제 감시 요구 사항에 따라 적절한 

화각으로 카메라를 장착합니다. 

예를 들어, 카메라를 천장에 설치 한 경우, 장치 케이블 아울렛 (로고) 과 감시 대상이 시계 방향으로 

교차하는 각도가 135° 일 때 파노라마 대상의 위쪽에 감시 대상이 표시됩니다. 

 

 

오른쪽 목록에서 Panoramic+4PTZ 미리보기 모드를 선택하면, 기본적으로 왼쪽에서 오른쪽으로, 

위에서 아래로 4 개의 로컬 이미지가 표시됩니다. 아래 그림과 같이, 각 로컬 이미지에서 PTZ 제어 및 

줌 조작을 수행할 수 있습니다. 

 

LOGO

Cable 
outlet

45°

Position of surveillance target
(e.g. access control)

Target

Target

Device 
bottom

360° Fisheye image in 
fisheye preview mode

Panorama image in 
panorama preview mode
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5  Video Playback and Download with Edge Storage 

 
NOTE! 

 Edge storage 는 비디오를 프런트 엔드 장치 (주로 카메라) 의 메모리 카드에 레코딩하는 것을 말합니다. 

로컬 레코딩이란 로컬 PC 클라이언트에 비디오를 레코딩하는 것을 말합니다. 

 Edge storage 로 비디오를 재생하기 전에, 카메라에 메모리 카드 및 저장 장치가 구성되어 있는지 

확인하십시오. 

 일부 모델에서는이 기능을 지원하지 않습니다. 자세한 내용은 실제 모델을 참조하십시오. 

 

Video Playback 

1. 홈 페이지에서 Playback 을 클릭합니다. 

 

2. 달력에서 날짜를 선택합니다. 

3. Query 를 클릭합니다. 

4. Results 에서, 레코딩 재생을 시작할 기간을 더블 클릭합니다. 

Download 

1. 홈 페이지에서 Playback 을 클릭합니다. 
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2. 지정된 기간의 비디오를 검색합니다. 결과가 목록에 표시됩니다. 

3. 비디오를 선택하고 Download 를 클릭하십시오. 비디오는 메모리 카드에서 로컬 경로로 

다운로드됩니다 (로컬 경로는 Local Settings 에서 변경할 수 있음). 

4. Open 를 클릭하여 다운로드된 비디오가 저장된 폴더를 표시합니다. 

6  PTZ Control 

이 기능은 PTZ 돔 카메라 또는 팬 / 틸트 모터가 설치된 박스 카메라에서만 사용할 수 있습니다.  

 
NOTE! 

 일부 렌즈 제어 기능은 모터라이즈드 렌즈가 장착 된 카메라에 사용할 수 있습니다. 

 PTZ 제어 버튼은 카메라 모델에 따라 다를 수 있습니다. 카메라가 지원하는 PTZ 제어 버튼에 대해서는 

웹 인터페이스를 참조하십시오.  

 

PTZ Control Toolbar 

Item Description 

Preset 

프리셋을 선택하고 를 클릭합니다. PTZ 카메라가 선택한 프리셋으로 

이동합니다. 

프리셋을 추가하려면 을 클릭합니다. 프리셋을 삭제하려면 을 

클릭합니다. 

Patrol 

패트롤 경로를 선택한 다음 을 클릭하여 패트롤을 시작합니다.  

 패트롤 경로를 편집하려면 을 클릭합니다. 

 패트롤 경로를 추가하려면 을 클릭합니다. 

 패트롤 경로를 삭제하려면 을 클릭합니다. 

 

PTZ 카메라의 이동 속도를 조절합니다. 
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Item Description 

 

PTZ 카메라의 방향을 제어하고 중단합니다. 

/  

/  

/  

/  

/  

IR 켜기 또는 끄기. 

Wiper 켜기 또는 끄기. 

Heater 켜기 또는 끄기. 

Illuminator 켜기 또는 끄기. 

Snow Control 켜기 또는 끄기. 

 

카메라 포커스 조정. 

 

카메라 줌 조정. 

 

Iris 지름을 증가 / 감소. 

 

PTZ 제어를위한 단축키. 라이브 뷰에서 마우스 커서가 이 모양 중 하나로 

변경되면 마우스, 왼쪽 버튼을 클릭 한 상태로 PTZ 카메라를 조작합니다. 

Note: 

 PTZ 돔 카메라와 PTZ 카메라만 이 기능을 지원합니다. 

 이 버튼은 3D 포지셔닝이나 디지털 줌을 사용할 때 사용할 수 없습니다. 

 

라이브 뷰에서 줌인 / 줌아웃을 위한 단축키. 휠을 앞으로 스크롤하여 줌인, 

뒤로 스크롤하여 줌아웃 합니다. 

Note: 

모터라이즈드 줌 렌즈가 장착 된 카메라만 이 기능을 지원합니다. 

 

Setting Patrol by Presets 

Setting Presets 

Preset 탭에서, 프리셋을 관리하거나 특정 제어 작업을 PTZ 카메라에 수행할 수 있습니다. 자세한 

내용은오류! 참조 원본을 찾을 수 없습니다.을 참조하십시오. 

Add a preset 

1. Live View 페이지에서, 제어판의 Preset 을 클릭합니다. 
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2. 원하는 방향으로 카메라를 조정합니다. 

3. 최적의 이미지를 얻기위해 줌과 포커스를 조정합니다. 

4. 를 클릭하여 프리셋을 추가합니다. 프리셋의 번호와 이름을 입력하고 OK 를 클릭합니다. 

Go to a preset 

1. Live View 페이지에서, 제어판의 Preset 을 클릭합니다. 

 

2. 프리셋의 를 클릭하십시오. PTZ 카메라가 선택된 프리셋으로 이동합니다. 

Delete a preset 

1. Live View 페이지에서, 제어판의 Preset 을 클릭합니다. 

1

2

3

4

1 2
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2. 프리셋의 를 클릭하고 삭제를 확인합니다. 

Setting Patrol 

패트롤 경로는 프리셋에서 다음 프리셋으로 이동할때 PTZ 카메라가 따라가는 경로입니다. PTZ 

카메라가 각 프리셋에 머물 시간은 설정 가능합니다. PTZ 카메라에는 여러가지 패트롤 경로가 

허용됩니다. 

패트롤 동작은 프리셋으로 이동하는 것과 다음 프리셋으로 이동하기 전에 일정 시간동안 머무르는 

것이 포함됩니다. 회전 방향, 확대 / 축소, 회전 속도, 패트롤 시간 및 체류 시간을 설정할 수 있습니다. 

시스템이 경로를 기록하고 작업 목록에 추가합니다. PTZ 카메라가 같은 경로를 따라 

패트롤하도록 Keep Rotating 을 선택할 수 있습니다. 

Add a patrol route 

1. Live View 페이지에서, 제어판의 Patrol 을 클릭합니다. 

 

1 2
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2. 를 클릭합니단. 

3. Add Patrol 페이지에서 경로 ID 와 이름을 입력하고, Add 를 클릭하여 패트롤 동작을 추가합니다. 

버튼들을 클릭하여 동작 순서를 조정합니다. 

패트롤 동작에는 다음이 포함됩니다: 

 프리셋으로 이동하는 것과 다음 프리셋으로 이동하기 전에 일정 시간 대기. 

 일정 시간 동안 설정된 방향과 속도로 회전, 줌, 일정 시간 동안 설정된 위치에서 대기, 또는 Keep 

Rotating 이 선택되어 있으면 패트롤을 반복. 

첫 번째 작업 타입은 Go to Preset 이 좋습니다. 

4. OK 를 클릭합니다. 

Record a patrol route 

1. Live View 페이지에서, 제어판의 Patrol 을 클릭합니다. 

 

2. 를 클릭하면 패트롤 경로 기록이 시작됩니다. 기록되는 동안 카메라의 방향과 줌을 조정할 수 

있습니다. 시스템은 카메라의 동작 및 트랙을 기록하고 동작 목록에 추가합니다. 

3. 를 클릭하여 기록을 마칩니다. 그러면, 패트롤 경로가 자동으로 모드 경로로 저장됩니다. 를 

클릭하여 패트롤을 시작하거나, 를 클릭하여 모드 경로를 삭제할 수 있습니다. 

1

2
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Make a patrol plan 

1. Live View 페이지에서, 제어판의 Patrol 을 클릭합니다. 

 

2. 를 클릭하십시오. 패트롤 계획 설정을 위한 페이지가 표시됩니다. 

3. 올바른 패트롤 시간과 경로를 설정합니다. 

4. Enable Patrol Plan 을 선택합니다. 

5. OK 를 클릭합니다. 

Start a patrol route 

패트롤 경로를 추가 한 후, 패트롤 경로를 선택하여 패트롤을 시작합니다. 

1. Live View 페이지에서, 제어판의 Patrol 을 클릭합니다. 

1

2
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2. 시작하려는 순찰 경로의 를 클릭합니다. 

Edit a patrol route 

1. Live View 페이지에서, 제어판의 Patrol 을 클릭합니다. 

 

2. 편집하려는 순찰 경로의 를 클릭하고, 필요에 따라 설정을 수정합니다. 

Delete a patrol route 

1. Live View 페이지에서, 제어판의 Patrol 을 클릭합니다. 

1

2

1
2
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2. 삭제할 순찰 경로의 를 클릭하고, 삭제를 확인합니다. 

Setting Home Position 

지정된 시간 내에 아무런 조작이 없으면 PTZ 카메라가 Home Position 으로 돌아갑니다. 

 
NOTE! 

 이 기능은 네트워크 PTZ 카메라에서만 사용할 수 있습니다. 

 먼저 프리셋이나 패트롤 경로를 추가해야 합니다. 자세한 내용은오류! 참조 원본을 찾을 수 없습니다. 

및오류! 참조 원본을 찾을 수 없습니다.를 참조하십시오. 

 

1. Setup > PTZ > Home Position 을 클릭합니다. 

 

2. Mode 와 ID 를 선택합니다. 

3. Save 를 클릭합니다. 

Remote Control PTZ 

타사 플랫폼을 사용하고 PTZ 프로토콜이 일치하지 않으면, PTZ 를 제어할 수 있는 원격 제어 기능을 

설정할 수 있습니다. 

 
NOTE! 

이 기능은 PTZ 카메라에서만 지원됩니다. 

 

1
2
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1. Setup > PTZ > Remote Control 을 클릭합니다. 

 

2. On 을 선택하여 Remote Control 을 활성화합니다. Listener Port 및 Address Code 를 설정합니다. 

다음 표는 몇 가지 주요 파라메터를 설명합니다. 

Acronym Description  

Listener Port 
카메라의 로컬 포트, 이미 사용중인 포트는 적용될 수 없습니다. 필요한 

경우에만 기본 설정을 변경합니다. 

Address Code 

카메라는 인스트럭션에 포함된 주소 코드를 읽을 수 있습니다. 카메라는 

인스트럭션의 주소 코드가 여기에 구성된 주소 코드 일 때만 

인스트럭션을 받아들입니다. 

 

3. Save 를 클릭합니다. 

PTZ Limit 

PTZ 카메라가 벽과 같은 장애물을 부딪히지 않도록 회전 제한을 설정합니다. 

 
NOTE! 

이 기능은 일부 PTZ 카메라에서만 지원됩니다. 

 

1. Setup > PTZ > PTZ Limit 를 클릭합니다.  

 

1

2

3

4
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2. 방향 버튼을 사용하여 카메라를 원하는 위치로 회전시킵니다. 

3. 를 클릭하여 현재 위치를 한도로 설정합니다. 예를 들어, 상단의 를 클릭하여 상한선을 

설정합니다. 방향이 변경되면 를 클릭하면 카메라가 현재 위치로 회전합니다. 

4. 위의 단계를 반복하여 필요에 따라 모든 제한을 설정하십시오 (위, 아래, 왼쪽, 오른쪽). 

5. Save 를 클릭합니다. 

6. Start PTZ Limit 를 클릭하여 설정을 적용합니다. 

7. 설정을 삭제하고 한계를 재설정하려면 를 클릭합니다. 

Resume Patrol 

1. Setup > PTZ > Patrol 을 클릭합니다. 

 

2. 패트롤이 재개되는 시간을 설정합니다. 

3. Save 를 클릭합니다. 

 

Appendix A Glossary 

Acronym Description  

ARP Address Resolution Protocol 

CBR Constant Bit Rate 

DNS Domain Name Service 

DDNS Dynamic Domain Name Service 

DHCP Dynamic Host Configuration Protocol 

DST Daylight Saving Time 

FTP File Transfer Protocol 

GOP Group Of Pictures 

GUI Graphical User Interface 

HTTPS Hyper Text Transfer Protocol over SSL 

IE Internet Explorer 

IMOS IP Multimedia Operation System 

IP Internet Protocol 

IPC IP Camera 

MTU Maximum Transmission Unit 
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Acronym Description  

NTP Network Time Protocol  

OSD On Screen Display 

PoE Power over Ethernet 

PPPoE Point-to-Point Protocol over Ethernet 

PTZ Pan, Tilt, Zoom 

ROI Region of Interest 

SMTP Simple Mail Transfer Protocol 

SSL Secure Socket Layer 

UNP Universal Network Passport 

USB Universal Serial Bus 

VBR Variable Bit Rate 

WDR Wide Dynamic Range 
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Appendix B FAQ 

What to do if no message prompts me to install ActiveX when I log in on a Windows 7 PC the first time 

Answer: Follow these steps to turn off UAC and then log in again:  

1. Click the Start button, and then click Control Panel. 

2. In the search box, type uac, and then click Change User Account Control Settings.  

3. Move the slider to the Never Notify position, and then click OK.  

4. After UAC is turned off, log in again. 

 

What to do if the installation of ActiveX failed 

Answer: If the installation failed, add the IP address of the camera as a trusted site: open Internet Option in 

IE, click the Security tab, click Trusted sites, and then click Sites to add the website.  

If you use Windows 7, you need to save the setup.exe to your PC first, right-click the file, select Run as 

administrator, and then install it according to instructions. 

 

What to do if live video fails when I log in for the first time 

Answer: Close the firewall on your PC and then log in to the Web interface again. 


